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Peter Travers Editor
peter.travers@futurenet.com

THE NO.1 CANON D-SLR PHOTOGRAPHY MAGAZINE!

Welcome to...
Canon Edition

n We’re the only magazine in  
the newsagent that’s 100% 
dedicated to Canon D-SLRs  
– making us 100% relevant  
to your needs.

n We’re 100% independent.  
We don’t answer to Canon  
and don’t rely on them for 
advertising – if Canon brings 
out a new camera or lens  
and it’s rubbish, we’ll say so!

n We’re all Canon D-SLR  
enthusiasts and between  
us we’ve got 200 years of 
photography experience.  
We’re excited about passing  
on what we’ve learned – even 
from our mistakes!

n We don’t assume you’re a 
millionaire. We focus on the 
Canon D-SLRs most people  
buy, and feature software  
and accessories within the 
average person’s budget.

n Our Video Disc has an 
unrivalled collection of D-SLR 
technique and Photoshop 
videos – which can be viewed 
via our digital editions too!

n We are proud to feature  
some of the best writers  
and photographers in the 
business. Turn to page six  
to meet them all now!

NEw DEALS!
Great print &
digital edition
   subscriptions 

   See page 22 for exclusive new offers!

3 fREE
GIfTS! Exclusive preview guide to the 50Mp Canon EOS 5DS, video lessons & The Photography Show 32-page mini-guide  See page 5 

N
ew Canon EOS D-SLRs are like buses. You wait for one to arrive, 
then four come along at once! But the new full-frame EOS 5DS 
is a camera worth waiting for. It’s the world’s first 50Mp D-SLR, 

surpassing Nikon’s 36Mp D810 in one giant digital leap. See our big 
preview guide to learn all you need to know about the incredible 5DS 
and 5DS R (page 55). There are also two worthy new entry-level 
D-SLRs, the EOS 750D and 760D. Both are impressive 24Mp 
machines, but the 760D gets a 70D-style body with top LCD and 
rear wheel control. See page 92 for more. Then there’s a new 
Canon CSC update, the EOS M3, plus Canon’s new EF 11-24mm 
f/4L USM, an amazing full-frame ultra-wide-angle lens (page 88).

 This month I was lucky enough to visit the Isle of Skye to 
photograph our Apprentice article. What an amazing place! 
Breathtaking mountain scene at every turn, and I experienced 
every sort of winter weather – in the space of a few hours! Our 
game Apprentice rose to the challenge and, with landscape pro 
Chris Rutter’s help, managed to capture some epic scenic shots 
(page 8). This issue we also have four top Canon pros sharing great 
lens techniques for capturing killer wildlife pictures (page 30).  
We have some great photo projects including cool smoke-art 
composites and light domes (page 43), and we test eight big 
telephoto zooms and primes (page 96). 

Plus, for UK readers, there’s a mini preview guide to The 
Photography Show 2015 – come and see me and the team, and 
Canon and lots more at the NEC in Birmingham, 21-24 March.
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3 free 
gifts!

 Rectilinear or curvilinear? p78   How can I keep it clean? p79   What’s the best way to focus in the dark? p79  

Great new subscription savings! Page 22

pArt 3: leNs sKills series 

GiFt 1

GiFt 3

Everything you need to know 
about the new 50-megapixel 
Canon EOS 5DS and 5DS R in 
our exclusive preview guide 
See page 55

Canon EoS 5DS 
prEviEw guiDE

GiFt 1

Your complete mini-guide to 
Britain’s foremost photography 
event at The NEC, Birmingham, 
21-24 March 2015 
http://downloads.
photoplusmag.com/TPS.pdf

photography 
Show guiDE 
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Wildlife pros share the tricks of 
the trade for shooting wildlife

Canon 
Lenses for 
wiLdLife

New Canon D-SLR and  
Photoshop projects!   
To view our videos, click on 
the ‘Watch the Video’ 
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tutorials. Click 
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to the right to 
see what 
videos are in 
store this issue…
See page 43
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Peter Travers
Editor • EOS 5D Mk III
peter.travers@futurenet.com

Adam Waring
Operations editor • EOS 7D
adam.waring@futurenet.com

“Canon has launched five new EOS 
cameras, including the 50Mp monster 

5DS full-frame D-SLR and 24Mp 750D 
and 760D entry-level D-SLRs – we 

preview them all inside!”

“The addition of a top-plate LCD and 
rear scroll-wheel on the 760D bestows 

this entry-level model with enthusiast-
line features. I reckon it’s easily 
worth the extra £50 over the 750D.”

Meet the

This issue’s contributors…

We are committed to only using magazine paper 
which is derived from well managed, certified 
forestry and chlorine-free manufacture. Future 
Publishing and its paper suppliers have been 
independently certified in accordance with the rules 
of the FSC (Forest Stewardship Council). 

Guy Edwardes
Four top-of-their-game 
wildlife pros share their 
secrets for our Canon Lens 
Skills Series. Joining Guy is 
Steve Bloom, Ben Hall and 
Alex Hyde. Page 30.

Ben McRae
Ben has been visiting the 
Himba tribespeople of 
Namibia for the past 
decade. He tells us how he 
lit a group portrait using a 
single flashgun. Page 114. 

James Paterson
For our Masterclass James 
produces a ‘time stack’ – a 
time-lapse with a difference 
– and shows you how to 
create time-saving actions 
in Photoshop. Page 66. 

Matt Richards
Technical writer • EOS 70D
photoplus@futurenet.com

“I’m looking forward to trying the EOS 
M3. Image quality should be great from 
its 24.2Mp sensor and DIGIC 6 processor, 

and it offers go-anywhere convenience 
for when my main D-SLR is too big.”

Angela Nicholson
Head of testing • EOS 5D Mk III
angela.nicholson@futurenet.com

“I’m really looking forward to putting the 
5DS R through its paces to see if its 

much-vaunted optical low-pass 
cancellation filter enables it to 
resolve more detail than the 5DS.”
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Print: 20,240
Digital: 4,289
Combined print and 
digital circulation for 
Jan-Dec 2014 is 24,529

Martin Parfitt
Art editor • EOS 600D
martin.parfitt@futurenet.com

“I’m loving those 50-megapixel sensors 
in the 5DS and 5DS R. Until now, my 

Canon lenses have looked too 
sharp and my computer’s 2TB 

hard drive is too empty…”

Hollie Latham
Technique editor • EOS 60D

hollie.latham@futurenet.com

“Wi-Fi and NFC built into the 750D 
and 760D mean no more messing 
around with memory cards when 

transferring images to the hard drive 
– great for lazy people like me!”

Chris Rutter
Chris and our Apprentice 
brave howling gales and 
snowstorms to capture 
epic landscapes on the Isle 
of Skye, up in the stunning 
Scottish Highlands. Page 8.

Join our interactive online communities…

Visit our interactive 
website for all your 
Canon EOS D-SLR 
photography needs, 
photos and videos.
www.digitalcameraworld.com

Our Facebook community 
is over 215,000 strong! 
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your shots, and ‘Like’ us!
www.facebook.com/
photoplusmag

Visit our Flickr group, 
view top shots, upload 
your images and enter 
our photo competitions!
www.flickr.com/groups/
photoplusmagazine

Follow us on Twitter 
and enjoy updates on 
new Canon gear, new 
camera techniques, 
photos, news and more. 
@photoplusmag
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Future is an award-winning international media 
group and leading digital business. We reach more 
than 49 million international consumers a month 
and create world-class content and advertising 
solutions for passionate consumers online, on tablet 
& smartphone and in print. 

Future plc is a public 
company quoted  
on the London  
Stock Exchange  
(symbol: FUTR).
www.futureplc.com

Chief executive Zillah Byng-Maddick 
Non-executive chairman Peter Allen
Chief financial officer Richard Haley 

Tel +44 (0)207 042 4000 (London)
Tel +44 (0)1225 442 244 (Bath)
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Landscape pro Chris Rutter proves you can capture epic 
landscape shots whatever the weather, as he takes our 
Apprentice on a wet, windy and stormy adventure on 

the Isle of Skye in the Scottish Highlands
Words and location shots Peter Travers

the
“Skye’s

Limit!”

The PhotoPlus Apprentice
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THE PRO...
Name: Chris Rutter
Camera: Canon EOS 6D

Although growing up in relatively flat Suffolk, 
professional landscape photographer Chris, 47,  
is most at home surrounded by big mountain 
scenery. Following a 15-year photo magazine 
career, he’s recently relocated from Bath to the Isle 
of Skye (which he’s visited regularly over the past 
20 years) to concentrate on Scottish landscape 
photography. For details of his photo workshops 
and accommodation, and amazing portfolio, go to 
www.chrisrutterphotography.com  

Name: Erliena Mitchell
Camera: Canon EOS 5D Mk III

Erliena, 58, is a keen photographer who’s 
been subscribing to PhotoPlus since 2008. 
Originally from Indonesia, she’s been living  
in Dumfries, in the Scottish Borders, for over 
30 years. Her first Canon EOS was a 50D, but 
she’s since upgraded to a full-frame 5D Mk III. 
She loves venturing out with her Canon 
D-SLR and lenses to photograph the 
surrounding beautiful scenery, but asked for 
our help to improve her shots.

THE APPRENTICE…

Limit!”
PhotoPlus April 2015  |  9

 Your chance to shoot with a pro

http://www.chrisrutterphotography.com


 

How to master 
Manual mode!
“Erliena was most comfortable shooting 
in Av mode, but while that’s good for setting 
a narrow aperture for a good depth of field 
for landscapes, her camera may well set 
an unsuitable shutter speed. Av mode will 
average out exposures of high-contrast 
scenes, and on Skye, scenes contrast 
highly, from the dark land to bright sky, 
with mountains often a mixture of both!” 
says Chris. “I got her to use Manual mode 
so she can capture the best exposure by 
setting both aperture and shutter speed. 
Your exposure in Manual is also locked and 
won’t jump around if the light in certain areas 
goes up or down.” For more on Manual mode, 
see our PhotoPlus Workshop on page 72.

EXPERT INSIGHT

ERLIENA’S TIP

Create a great panoramic photo! 
The expansive Scottish Highlands are perfect panoramic shots. For this image 
I combined four overlapping shots, using Photoshop’s Photomerge feature. This 
was shot into the sunset, which was backlighting the clouds behind the castle.

 Erliena’s comment
“Before we crossed the bridge to Skye, we 
had the pleasure of photographing the iconic 
Eilean Donan castle. We were very lucky as we 
had a rare bit of sunshine to light the castle, 
and blue sky behind! I used an aperture of 
f/11 and focused on the castle itself. Chris 
suggested cropping to the 16x9 ‘wide-screen’ 
format to reduce the amount of empty 
water and sky. We also used a cool white 
balance setting when editing the Raw file to 
emphasise the blue sky and its reflection.”

The PhotoPlus Apprentice
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PhotoPlus Technique assessment
Is Erliena all set to shoot 
stunning Scottish scenes?
Landscape pro Chris helps our Apprentice get her Canon D-SLR ready for a Highland fling…

Consistent white balance
“Auto White Balance (AWB) will make 
a good fist of setting an accurate white 
balance in sedate conditions, but with 
Skye’s ever-changing weather, it can result 
in a set of wildly different shots. So I set WB 
to Daylight for consistency; you can always 
tweak the white balance in Lightroom or in 
Adobe Camera Raw to get the best colour 
temperature for your specific scene.”

Raw image control
“Always, always shoot in Raw. It gives you the 
best possible image quality and highest-
resolution file from your Canon D-SLR,” says 
Chris, “A Raw file also gives you a huge amount 
of freedom when it comes to processing your 
shots, and boosting exposures. I use Adobe 
Photoshop Lightroom and I’m able to 
transform a shot taken on dull, stormy Skye 
day into a vibrant, winning landscape image!”

Exposure: 1/30 sec at f/11; ISO100 
Lens: Canon EF 24-105mm f/4L IS USM

 Your chance to shoot with a pro

PhotoPlus April 2015  |  11

KILLER KIT OF 
THE PROS #1
Wet weather gear
“We had snow blizzards, hail, 
sleet, rain, fog and strong winds 
– all in one morning! But there’s 
no such thing as bad weather, just 
bad clothing,” nods Chris sagely. 
“I wear lots of woollen layers, 
a top-quality wind- and waterproof 
jacket and over-trousers, plus 
fleece gloves and hat. A stout pair 
of warm, waterproof and leather 
walking boots are crucial, too.”  



  

Be prepared to trek to find the 
best landscape locations…

KILLER KIT OF THE PROS #2
Black plastic bin liners

Chris straps a couple of 
strong plastic bags to his 

backpack. “They’re 
great for popping over 
the tripod to protect 
your camera and lens 
if there’s a sudden 
downpour, plus I’ll use 

them to kneel or lie on 
when it’s wet and muddy.”

 Erliena’s comment
“When there was a big, colourful sky, 
Chris encouraged me to be bold with my 
composition and include more of it in shot. 
We got down to the water’s edge for this 
shot of the Isle of Scalpay, across from 
Skye. Chris’s polariser and a 2-stop ND was 
enough, at f/22, to obtain a five-second 
exposure that’s smoothed out the water, 
and also caught some nice movement in the 
big clouds passing overhead. There’s even 
a dash of a rainbow, if you look closely.”

The PhotoPlus Apprentice

Learn to shoot quickly! 
“The weather on Skye changes by the 
minute, so you need to be confident 
with your settings, and able to set up 
your camera and tripod the instant 
there’s a break in the weather. Stowing 
your gear neatly in your backpack really 
speeds up unpacking time,” says Chris.

CHRIS’S TIP

Standard picture style
“Although your Canon D-SLR has 
various picture styles, including a 
Landscape setting that emphasises 
greens and blues for the land and skies, 
I’ve found that Standard captures the 
best range of tones for my photos,” says 
Chris. Remember that picture styles 
can’t be edited in JPEGs, and while you 
can change the picture style in a Raw file 
afterwards if using Canon’s DPP 
software, Photoshop doesn’t recognise 
Canon’s picture styles.

CHRIS’S TIP

12  |  PhotoPlus April 2015



  

 Your chance to shoot with a pro
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 Erliena’s comment
“The wind was howling and heavy rain was falling, but we dashed out of the car 
and bagged a few handheld shots while the sun was highlighting the mountains 
over Loch Ainort. I zoomed in to 105mm to focus on the most interesting part 
of the scene. As we were focusing at such a distance, Chris explained an 
aperture of f/8 will capture enough depth of field. 
We cropped this into a mini-panorama 
format to suit the shape of the land.”

KILLER KIT OF THE PROS #3
Full set of lens filters
“Thanks to the wonderful moody weather, 
and the mountains blocking the sun, light 
levels are often already so low to enable 
slow enough shutter speeds to capture 
movement in skies and water as motion 
blur – I rarely use a 10-stop ND filter here! 
But I nearly always use a 2-stop ND grad 
to hold the light back on bright skies, and 
always use a polariser to add punch and 
to boost colours, as well as reducing 
reflections in water.”  

Exposure: 5 secs at f/22; ISO100 
Lens: Canon EF 24-105mm f/4L IS USM

Exposure: 1/250 sec at f/8; ISO200 
Lens: Canon EF 24-105mm f/4L IS USM
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The PhotoPlus Apprentice

KILLER KIT OF THE PROS #4 
Maps and plans
“I’ve collated a wealth of OS maps over the 
years and I love studying them – they’re 
essential for getting the lie of the land and 
working out trails for getting to hard-to-
reach locations,” says Chris. “Have a plan 
of where you want to photograph, but be 
flexible – the weather usually dictates 
which locations are the most photogenic!”

Microfibre cloths
“Don’t let rain spots on your lens ruin your 
landscape shots. Simply carry a microfibre cloth 
(I keep mine in plastic ziplock bags in my coat 
pockets) and wipe lenses clean before taking shots. 
A lens hood will also shield the glass; it helps if you 
try and shoot downwind, too. I also carry small 
towels to wipe rain off my camera and lenses, 
to avoid packing them away damp,” says Chris.

CHRIS’S TIP

Exposure: 1 sec at f/22; ISO100
Lens: Canon EF 16-35mm f/2.8L II USM
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 Your chance to shoot with a pro

 Erliena’s comment
“Chris knew of this atmospheric 
derelict church not far from 
Broadford. The heavy clouds meant 
it was so dark – even though it was 
midday! – that a narrow aperture 
of f/22 gave us a one second shutter 
speed to subtly capture some motion 
blur in the clouds. Chris helped me to 
convert the shot to black and white, 
darkening the sky with a digital grad 
filter, and boosting the shadows. 
He cropped it with a 5x4 ratio to 
emphasise the imposing sky.”

Grey-Skye 
thinking
Mountain man Chris Rutter’s 
choice of Skye landscapes

Elgol Bay

1 “This was taken after sunset from the 
cliffs above Loch Scavaig near Elgol. 

Despite the overcast conditions, I was able 
to reveal the detail in the clouds using a 0.75 
ND grad (2.5 stops) and 30-sec exposure to 
capture them moving across the sky.”

Rainbow over the Red Cuillin

2“I’d been standing here for around 
20 minutes in heavy rain, waiting 

for a break in the cloud, when this 
rainbow appeared. Luckily I had set 
my camera up before the rain, complete 
with a 0.6 ND grad, so all I had to do 
was uncover it and get the shot.” 

“Dig the tripod legs into soft ground to ensure it’s solid, and use Mirror Lock-up and a 
remote release to fire the trigger,” advises Chris. “Turn IS off, then use Manual focus and 
Live View and zoom in x10 to focus one third into the scene. Try to shelter the camera 
from the worst of the weather using rocks or knolls, or block the wind with your body.”

EXPERT INSIGHT

KILLER KIT OF THE PROS #5 
Top quality light lenses
“To complement the compact, full-frame 6D, 
the main Canon EF lenses I use are the 
16-35mm f/4L, 24-70mm f/4L and 70-200mm 
f/4L. Being L-series they’re all razor-sharp, but 
at f/4 they’re much more portable than the 
weightier f/2.8 versions, plus you don’t need 
such fast lenses for landscapes,” says Chris.

Guaranteeing sharp shots

Trotternish Ridge at sunrise

3 “Another shot where perseverance paid 
off, as the 

clouds cleared 
just as the sun 
rose for this 
classic view from 
the Quiraing 
looking along the 
Trotternish 
Ridge. I used a 
0.6 ND grad to 
keep detail in the 
sky, and an 
aperture of f/22 
to get maximum 
depth of field.”  



  

The PhotoPlus Apprentice
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Exposure: 1/6 sec at f/16; ISO100 
Lens: Canon EF 16-35mm f/2.8L II USM

 Erliena’s 
comment
“One of the benefits 
of all the wet 
weather is the rivers 
and waterfalls are 
massive and always 
gushing, which 
makes for better 
landscape photos 
that are full of 
energy! As the water 
is moving so fast, 
and the light levels 
were low, it meant 
our resulting 1/6 
sec shutter speed 
(when shooting at 
f/16) easily blurred 
the fast-flowing 
waterfall, without 
smoothing it out so 
it looks bland.”

Healthy histograms
“It’s great being able to instantly 
check your shots on your Canon’s 
LCD, however to check your image’s 
range of tones it’s best to look at the 
histogram (press Info or Disp when 
reviewing images to bring up the little 
graph). Then you can check if the 
image has a healthy histogram,  
and isn’t ‘clipped’ – off the right  
if overexposed, off the left if 
underexposed. If it is, adjust your 
shutter speed to brighten or darken 
the image and take more shots  
until the graph isn’t clipped. But 
remember, while you can always 
brighten a dark shot in Photoshop, 
you can’t darken an overly bright 
shot if there’s no detail to rescue.”

CHRIS’S TIP
KILLER KIT OF THE PROS #6
Flask of hot coffee!
“Skye doesn’t have a Starbucks on every corner – 
or any corner, for that matter!” laughs Chris, 
“There aren’t many cafés on Skye, and the few 
we have aren’t open during the winter, so I always 
carry a flask of hot filter coffee with me. It saves 
money, and means I have a hot drink to warm me 
up and keep me going on cold shoots. It also 
means you can stay out on location longer, ready 
to shoot once there’s a break in the weather.”



  

 Your chance to shoot with a pro
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Exposure: 1/5 sec at f/15; ISO100   
Lens: Canon EF 16-35mm f/2.8L II USM

 Erliena’s comment
“I was amazed how this finished shot 
looked after Chris had waved his magic 
Lightroom wand over it! It was so dark 
and stormy, I didn’t think there was 
enough light or detail to reveal. Although 
the mountains are shrouded in cloud, 
Chris said he preferred these moody, 
biblical skies! We composed the shot 
vertically, getting low with my tripod 
then pointing the lens (set to 20mm) 
down to enlarge the rocks and river in 
the foreground. He explained I need to 
be careful composing low down with a 
wide 16-35mm on my full-frame 5D Mk 
III as, at 16mm, foreground elements can 
appear huge, while distant mountains 
become small and insignificant.”

 
Enhancing Raw 
landscape images 
in Lightroom

Basic exposure adjustments – 
lighten the Shadows and then 

darken the Blacks to give them a bit 
more ‘punch’. Then add a little Clarity to 
increase the local contrast and add 
some Vibrance and Saturation.

 Add a Gradient to the lower half of 
the image, and then lighten the 

Shadows to make the foreground much 
clearer. Also lighten the Highlights and 
add a little Contrast and Clarity.

 Use the Adjustment Brush, and 
paint over the middle distance, 

which is still quite dark. Lighten it by 
increasing the Exposure and Shadows, 
just a little, to bring back detail without 
affecting the foreground or background.

STEP-bY-STEP

Canon EOS 6D
Canon EOS 600D
Canon EF 16-35mm f/4L IS USM
Canon EF 24-70mm f/4L IS USM
Canon EF 70-200mm f/4L IS USM
Sigma 10-20mm f/4-5.6 EX DC HSM
Sigma 17-70mm f/2.8-4 DC Macro OS HSM
Lee Filters ND, ND grads and circular polariser
Light Craft ND-500 10-stop ND filter
Manfrotto 190L tripod
Manfrotto 804RC2 3-way head
Several microfibre cloths & bin bags  

CHRIS’S KIT
Chris carries this 
little lot within – and 
strapped onto – his 
Lowepro Pro Runner 
300 AW backpack…

FINAL IMAGE
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Chris’s verdict
“Erliena was a real trooper, as we had some very ‘special’  
Skye weather conditions to contend with throughout our time! 
This is a breathtaking shot across the Glen Sligachan with the 
Marsco peak [1] (part of the Red Cuillin mountain range) stood 
proudly on the horizon. She’s composed the shot well, with  
the raging river and battered rocks mirroring the similarly 

speckled black-and-white colouring of the mountain tops, creating wonderful 
foreground interest [2]. Using a 2-stop ND has slowed the exposure down to blur 
the water [3], while a polariser has reduced the reflections on the water, as well 
as boosting the contrast of the shiny rocks [4]. An epic Shot of the Day!”

The PhotoPlus Apprentice

[1]

[4]

[2]

[3]



  

Exposure: 1 sec at f/16: ISO100 
Lens: Canon EF 24-105mm f/4L IS USM

Erliena’s comment
“Photographing Skye and the Scottish 
Highlands was such an experience – it’s 
a lot different to the Borders, that’s for 
sure! The Sligachan area, where we shot 
this landscape, was one of my favourite 
places to take pictures as there were 

incredible views in every direction. This viewpoint was a fair 
trek from the car park, but well worth the hike as the river 
was really surging over the rocks; in stark contrast to the 
serene mountains standing still in the distance.”  n

be our next 
Apprentice!
Do you need some help to take your 
Canon photography to the next level? 
Let us know what you’d like help with and 
we could pair you up with a top pro for the day. 
Send us an email to photoplus@futurenet.com 
with ‘PhotoPlus Apprentice’ in the subject line,  
and include your telephone number and address. 
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Next issue White-water sports!

mailto:photoplus%40futurenet.com?subject=PhotoPlus%20Apprentice
page://113
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PhotoPlus Mail Box

YourLetters
Send us your comments on the magazine, and photography in 
general. Drop us a line any time at photoplus@futurenet.com

Subscriptions & 
digital editions
PhotoPlus is the 
best magazine for 
all Canon EOS D-SLR 
photographers. If 
you’ve missed a back 
issue, or want to save 
money, why not start  
a subscription? 

PhotoPlus is available  
in print with our Video 
Disc, and also as an 
enhanced digital 
edition, with all videos 
included. For iPad and 
iPhone users, download 
the Apple Newsstand 
app; Android and PC 
users can use Zinio  
to download digital 
editions; we’re also 
available on Amazon’s 
Kindle Fire, Nook and 
Google Play.

For print and digital 
subscriptions go to:  
http://bit.ly/
photoplusmag

New print & digital 
subs deals on page 22!

WIN NEW 16GB mEmory 
cards aNd rEadEr!
Every LETTER OF THE MONTH winner gets either a Kingston 
Technology 16GB Ultimate CompactFlash 600x or 16GB SDHC 
Ultimate Class 10 flash card, plus a Kingston MobileLite G3 card 
reader!  www.kingston.com/uk 

PhotoPlus Index
I’d like to know if there’s a PhotoPlus 
index of your magazines I can use 
when I’m looking for info, articles and 
past tests, rather than having to 
browse through all of them. I’ve got all 
magazines since No.1 and sometimes 
struggle to find what I want…
Jordi Puigtio Milton Keynes
Yes we do indeed – please go to 
http://downloads.photoplusmag.
com/PhotoPlus_Index.xls to 
download the Excel document.

You helped me buy 
a… wide prime!
Just a quick note to say thanks for your 
help last year when you allowed me to 
try out five fast wide primes on a photo 
shoot with Hollie for the ‘Help Me Buy’ 
article (issue 91). I got a great deal on  
a Canon EF 24mm f/2.8 IS USM (the 
lens I chose) shortly afterwards, and 
I’m very happy with it – I’ve been really 
enjoying photographing landscapes 
and roller derby with my new lens.  
It was great to ‘try before you buy’ as  

I came away knowing exactly what I 
wanted. Keep up the great work with 
PhotoPlus, I’ve just renewed my 
subscription for another two years!
Phil Seymour Birmingham

Join the club!
I was asked by a fellow 
photographer if I would start a 
camera club as it was something 
we were short of in the local area. 
I wasn’t too keen at first, but I got 
involved and now think it’s a super idea as lots of people 
want to learn how to take decent photos – and some 
might even want to be great photographers. 

So now I run the Mercat Camera Group at the 
Mercat Centre in Kildary (7.30pm, every second 
Tuesday). It is good fun, attended by a friendly bunch 
who vary in ages, abilities and cameras, from compacts 
to D-SLRs; it doesn’t matter how old you are or what 
camera you have, you are welcome at the club! 

We have outings, or ‘photo shoots’ as we like to call 
them, where we go out at weekends or at night as a 
group and learn from each other. We do a lot of practical 
projects, where if anyone needs any help (and they 
usually do!) I show them what settings to use or how to 
operate their cameras. I am always taking notes of the 
hints and tips I get from PhotoPlus and I try to use them 
to help our photographers to learn as much as possible. 

I’ve enclosed a shot from one of the group’s recent 
photo shoots, taken at Fairy Glen, Rosemarkie.

I do try my best but I am hoping that one day some 
more experienced photographers will take over and 
make the club even better!
Duncan Meechan Tain, Scottish Highlands
We wish you every success with the Mercat Camera 
Group, Duncan! Joining a camera club is a fantastic 
way to learn from fellow photographers, and if there 
isn’t one in your local 
area, why not start 
your own up, as 
Duncan has…

mailto:photoplus%40futurenet.com?subject=Your%20Letters
http://bit.ly/photoplusmag
http://bit.ly/photoplusmag
page://22
page://22
http://www.kingston.com/uk
http://downloads.photoplusmag.com/PhotoPlus_Index.xls
http://downloads.photoplusmag.com/PhotoPlus_Index.xls
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PhotoPlus’s friendly online community…

Join us online today!
Facebook www.facebook.com/PhotoPlusMag
Twitter @photoplusmag
Camera reviews www.techradar.com/cameras
Magazine website www.digitalcameraworld.com
Flickr www.flickr.com/groups/
photoplusmagazine

It’s PhotoPlus Friday 
Facebook Fun time! 

Every Friday at 1pm (UK time) 
we aim to bring you a fun 
challenge or giveaway…
 
Canon has announced not one, 
but FIVE new EOS cameras 
today, from the pocket-sized 
EOS M3, to the 750D, and 760D 
(which adds a top-plate LCD 
and rear scroll-wheel to an 
entry-level model for the first 
time), and 50-megapixel 
monsters the 5DS, and its 5DS 
R variant. Tell us which has you 
the most excited, and why.  
PhotoPlus

Just when I was 
thinking of upgrading 

my 5D Mk II to the 5D Mk III, 
they bring the 5DS out and a big 
brother in the 5DS R to choose 
from. I envisage some agonising 
decisions ahead until I bite the 
bullet. It would be rude not to.
Graham Currey 

Hopefully the 5D Mk III 
will come down in price 

and I will get one of those. Can’t 
justify £3000 for the 5DS, 
though I’d love one.
George McLaren 

I’m happy with my 
650D. I’d consider the 

760D over the 70D, which I had 
planned to buy next year, and 
keep my 650D as a spare.  
The 760D is better specced. 
But I believe there are too many 
models in Canon and Nikon’s 
ranges and they’re too busy 
trying to outdo each other to 
care about real R&D into what 
consumers want in a camera.
Jim Bryce 

Just as I was about to 
upgrade from a 500D 

to a 700D! Now I don’t know 
which to go for. The 760D looks 
promising. I’ll wait until they’re 
in stock then have a closer look.
Graham Taylor

50Mp but only 
ISO6400? I’d rather 

have better low light ability than 
more pixels. 50Mp is only of 
benefit if you wish to crop or 
print large.
Duncan Rounding 

I’m saving to get my 
hands on the 760D.  

It seems the obvious bridge 
between the lower and higher 
cameras and would mean not 
so much of a skills jump.
Mat Horlock 
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Polarised opinion 
In your issue 97 (March 2015) you 
profiled the Canon EF-S 10-18mm 
f/4.5-5.6 IS STM lens. I’m really glad  
to see this lens given the credit it 
deserves, but you omitted the cost of 
a Canon 67mm polarising filter! The 
lens retails for around £245, but then 
you have to pay a whopping £150 for 
the circular polariser filter. Do you have 
any recommendations for a polarising 
filter that will match the high 
standards  of the lens?
George Haines Harrow, Middlesex
It is a cracking little EF-S wide-angle 
lenses, and great value too. You can 
get decent 67mm circular screw-on 
polarisers for the EF-S 10-18mm 
lens from Tiffen and Hoya for 
around £45 to £77 respectively. 
However, we’d advise against using 
a polariser on such a wide-angle 
lens as you’ll find the polarising 
effect won’t be consistent across 
such a wide area – it will appear 
darker on one of side of the frame 
compared to the other.

Sensor-less!
I see from your online coverage that 
Canon has bowed to the pressure of 
keeping up with the megapixel race 
and put a 50Mp sensor into its latest 
5DS – more than doubling the 
previous pixel count of the 5D Mk III. 
No doubt this will get certain people 
very excited, but unless you’re 
planning on printing your images onto 
a billboard, this ever-increasing pixel 
count is unnecessary.

A 6Mp sensor is perfectly 
adequate for an A4 print, 
and 12Mp is more than 
enough for A3. The more 
megapixels you pack 
onto a sensor, the smaller 
each individual photosite 
has to be, and the less 

responsive it is to light – borne 
out by the fact that the 5DS tops 
out at just ISO6400 – compared 
to the 5D Mk III’s ISO51,200!

Not only that, but the act of 
browsing your images, opening 
them up on your computer  
and editing them will take ages, 
and your hard drive will soon 
become full-to-bursting! I’ll be 
sticking with my 70D, thanks!
Andrew Owens Cleethorpes

We played with a pre-production 
5DS for this issue’s preview guide 
(page 55), and will be giving the 
camera a full review, including an 
in-depth analysis of its image 
quality, just as soon as Canon can 
send us one. We’ll reserve our 
judgement until then! 

Where are the digital 
edition start files? 
I have a digital subscription to the 
magazine and would like to know how 
I go about obtaining the start images 
used in the tutorials.
Malcolm Thomas via Facebook
Whenever a tutorial has 
accompanying project files, we print 
a link at the bottom of the page, but 
you will need to download these 
onto a computer, rather than onto 
your tablet. It you tap the link on the 
iPad versions of our digital editions, 
it create an email to send to yourself 
with the links; if you’re using 
another type of tablet or viewing it 
on a computer, just type the web 
URL directly into your browser’s 
address bar on your computer. n

Type this into 
your computer, 
rather than your 

tablet, to access 
our project files…

You don’t need to use a polarising 
filter with a wide-angle lens – in 
fact, we’d advise against it…

http://www.facebook.com/PhotoPlusMag
http://twitter.com/photoplusmag
http://www.techradar.com/cameras
http://www.photoplusmag.com
http://www.flickr.com/groups/photoplusmagazine
http://www.flickr.com/groups/photoplusmagazine
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Print and digital subs deals!

Read what matters to you when and where you want
Whether you want PhotoPlus delivered to your door, your device, 
or both each month we have these great offers to choose from…

Print

Ultimate Canon Pack

Digital
OFFER 1

OFFER 4

OFFER 2

  Save up to 35% 
  FREE gifts each issue, 
including a Video Disc
  Every issue delivered 
direct to your door
  FREE Manfrotto 
Compact Advanced 
Monopod worth 
£29.95

From £26.49 
(based on a six-month 
subscription) 

  Available on Apple  
and Android
  Interactive content: 
pop-up video and 
image galleries
  Keep every issue  
on your tablet or 
smartphone and 
search content easily
  Gifts included in issue 

From £19.99 
(based on a six-month 
subscription)  

Quote code PMPRINT15 Quote code DIGITAL15

SAVE
UP TO

45%
SAVE
UP TO

35%

Subscribe to

WORTH

£241This offer is for new UK subscribers only. Based on a one-year subscription saving 36% on the shop price and 
giving you a 87% discount on a digital subscription. Prices and savings based on UK print and digital issues.

Enjoy a PhotoPlus subscription PLUS goodies worth a total of £241. 
Get the most from your Canon D-SLR with this essential pack.

The pack includes: 
  A one-year subscription to  
PhotoPlus both in print and digital
  A Manfrotto Agile Sling Bag worth £69.99
  The Ultimate Canon SLR Handbook Vol. 3
  Master Your Canon D-SLR DVD

All this for just £89.99
Quote code UCPBUNDLE 
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Prices and savings quoted are compared to buying full priced UK print and digital issues. You will receive 13 issues in a year. If you are dissatisfied in any way you can write to us or call us 
to cancel your subscription at any time and we will refund you for all unmailed issues. Prices correct at point of print and subject to change. Gift is subject to availability.  

Please allow up to 60 days for the delivery of your gift. In the event of stocks becoming exhausted, we reserve the right to replace with items of a similar value.  
For full terms and conditions please visit: myfavm.ag/magterms. Offer ends 15 April 2015.

New subscription offers!

 *Manfrotto Compact Advanced Monopod comes with print and print+digital subscriptions to PhotoPlus for UK customers only.

How to subscribe
Visit www.myfavouritemagazines.co.uk/phpmonopod

Or call 0844 848 2852 and quote PMPRINT15, DIGITAL15, PMBUNDLE15 oR UCPBUNDLE

The Manfrotto Compact Advanced Monopod is 
the ideal accessory for capturing pictures and 
movies. Designed to be lightweight and 
travel-friendly, you can quickly attach your 
camera with one hand using the quick wheel. 
In addition, the reinforced aluminium tubes and 
five-section design means you can reach a height 
of 1.55m while maintaining shooting stability.

OFFER 3

Print + Digital
Enjoy the latest news, techniques and inspiration delivered to 
your door and instantly available on your Apple or Android 
device. Each issue includes free gifts and interactive content. 

SAVE
UP TO

59%

  Save up to a massive 59%
  Print copy to read at leisure plus 
digital edition to archive
  FREE Manfrotto Compact  
Advanced Monopod worth £29.95

 
From £31.99
(based on a six-month subscription) 

Quote code 
PMBUNDLE15
Your subscription will then continue at £31.99 
every 6 months – SAVING 26% on the shop 
price and giving you an 83% discount on a 
digital subscription.

GIFT 
WoRTh

£29.95
*With our UK print and  bundle subscriptions

watCh
thE viDEO

http://bit.ly/PP_98

http://myfavm.ag/magterms
http://www.myfavouritemagazines.co.uk/phpmonopod
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Great Canon photographers in action

Sunrise at Winnats Pass by Sven Mueller 
Visit Britain award
“I took this early in the morning on the second day of my 
three-week-long travels through the United Kingdom and 
Ireland in May 2014. I had hiked up the walls of the pass a few 
hours before and was waiting alone up there until the first sun 
rays hit the countryside. The image shows the kind of landscape 
that I most enjoy in the United Kingdom.” 
Camera: Canon EOS 5D Mk II  Lens: Canon EF 16-35mm 
f/2.8L II USM  Exposure: 1/6 sec at f/9; ISO100  

Sven M
ueller / Landscape Photographer of the Year, Take a View

 2014
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PhotoPlus Inspirations

AboVe

Seven Sisters Storm by Nigel Morton 
ClassiC View HigHly Commended
“I made several visits to Hope Gap to try and capture the scale 
and drama of the cliffs in the most striking conditions possible. 
At the beginning of 2014, the UK was battered by a series of 
storms. I managed to make several photographs, including 
this panoramic image encompassing all seven of the sisters.”  
Camera: Canon EOS 6D  Lens: Canon EF 70-200mm 
f/4L USM Exposure: 1/30 sec at f/18; ISO100

RIGHT

Last of the Cornice by David Kirkpatrick 
liVing tHe View 
“It was approaching the end of winter when we climbed the 
Monadhliath Mountains in Scotland. Towards the end of the 
circuit we came across this impressive overhanging cornice 
approaching Càrn Dearg. To make the most of the sense of 
scale, my walking buddy Graeme doubled up as a useful model.” 
Camera: Canon EOS 6D  Lens: Canon EF 24-105mm 
f/4L IS USM  Exposure: 1/200 sec at f/16; ISO100

LefT

Two Hundred and 
Six Beach Huts by 
Tim Harris 
your View runner up 
“This is a composite of over 
200 separate exposures, one 
for each of the beach huts 
along the Norfolk coast at 
Wells-next-the-Sea. I wanted 
to show the diversity of 
individual styles for the huts 
– different colours, different 
designs and different states 
of repair. I worked along the 
line of huts one by one, 
taking separate exposures of 
each directly from the front 
for a consistent viewpoint in 
the combined image.” 
Camera: Canon EOS 5D Mk II 
Lens: Canon EF 24-105mm 
f/4L IS USM  Exposure: 
1/250 sec at f/8; ISO640 

D
avid Kirkpatrick / Landscape Photographer of the Year, Take a View

 2014
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Great Canon photographers in action
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RIGHT

Bright Eyes – Hope Valley from the  
Great Ridge by Dave Fieldhouse 
ClassiC View HigHly Commended
“Having watched the sun rise over Mam Tor, I followed the path 
towards Hollins Cross. I set up to take the shot when I noticed 
I wasn’t the only one enjoying the view this particular morning.” 
Camera: Canon EOS 5D Mk III  Lens: Canon EF 70-200mm 
f/4L IS USM  Exposure: 1/4 sec at f/16; ISO100 

beLoW

Cloud Clearing Cribyn Brecon  
Beacons by James Osmond 
sunday times magazine CHoiCe
“Ten minutes before reaching the summit of Pen y fan, a  
layer of cloud obscured the view. I knew which view I wanted 
to capture, so I set up the tripod, hoping that a momentary 
break in the cloud might reveal something special. It did.”
Camera: Canon EOS 5D Mk II  Lens: Canon EF 17-40mm f/4L 
USM  Exposure: 1/320, 1/100 & 1/30 sec at f/13; ISO100   

Jam
es o

sm
ond / Landscape Photographer of the Year, Take a View

 2014
D

ave fieldhouse / Landscape Photographer of the Year, Take a View
 2014
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LaNDSCaPE PHOTOGRaPHER 
OF THE YEaR, TaKE a ViEW 2014

beLoW

London Bridge Station by Stephen Bright 
network rail award
“Taken at sunset, this is the view from level 72 of The Shard, 
looking almost straight down onto some of the platforms at 
London bridge station. Shooting at an oblique angle through 
glass can be problematic, although thankfully The Shard 
viewing platform has single glazing in many places. However, 
that benefit is counterbalanced by the fact that tripods are not 
permitted, requiring imaginative use of other supports.”  
Camera: Canon EOS 5D Mk II  Lens: Canon EF 24-105mm 
f/4L IS USM  Exposure: 1/125 sec at f/4.5; ISO3200

AboVe

Cairngorms National Park 
in Winter by Tim Taylor 
liVing tHe View runner up
“Winter storm; battling high winds and heavy snowfall 
en route to the summit. Unforgiving conditions, perfect 
for team training prior to our Himalayan expedition and 
a wilderness photographers’ muse.” 
Camera: Canon EOS 5D Mk II  Lens: Canon EF 24-105mm 
f/4L IS USM  Exposure: 1/200 sec at f/13; ISO250  n

AboVe

at the Edge by Rod Hanchard-Goodwin 
liVing tHe View
“The view of edinburgh city from Salisbury Crags is a stunning 
one but I wanted to include the Crags and provide a sense of 
scale in the shot with a person. The sidelight lasted for a few 
minutes before the sun was covered by clouds.” 
Camera: Canon EOS 6D  Lens: Canon EF 24-105mm  
f/4L IS USM  Exposure: 1/40 sec at f/11; ISO400

Landscape Photographer 
of the Year awards are run 
in association with the 
awards’ sponsors, Visit 
Britain and Countryside  
is Great. Landscape 
Photographer of the Year: 
Collection 8 is out now 
(AA Publishing, £25). See 
www.take-a-view.co.ukSt
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 Taylor / Landscape Photographer of the Year, Take a View
 2014

Rod H
anchard-G

oodw
in / Landscape Photographer of the Year, Take a View

 2014

http://www.take-a-view.co.uk
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Page 32 Page 34

Canon Lenses 
for wiLdLife
Four top Canon wildlife pros tell you how to get the best from your lenses…

Part 3

With Guy Edwardes

TeLephoTo  
zoom Lenses

With Steve Bloom

wide-angLe  
zoom Lenses

page://32
page://34
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Wildlife is certainly one of the more 
challenging subjects to capture 
with your Canon camera – which 

is perhaps why it is so rewarding when you 
do finally bag a great nature shot. 

Not only do you need to understand  
your subject’s behaviour and its natural 
habitat, you also need to have the patience 
to wait for the wildlife to make their grand 
appearance. Animals can be very 
unpredictable, and in some cases you  
will only have a split-second to capture  

the story unfolding in front of you. So 
arming yourself with the right lens for the 
job – and knowing the best techniques to 
apply at a moment’s notice – is vital to 
capturing stunning and unique shots.

So, in this third part of our Canon Lens 
Skills Series, we are focusing on wildlife 
photography. You’ll get an insight into how 
you can capture great images using a 
variety of lenses and learn the key skills  
you need for choosing the right optic for 
different situations. Four top Canon pro 

wildlife photographers share the benefit of 
their knowledge and experience to show 
you killer techniques shooting the natural 
world with a range of focal lengths, from 
ultra-wide to super-telephoto, and how to 
get the best results. 

So, whether you want to get up close and 
personal with your subjects or keep a safe 
distance, we’ve got some top tips on how to 
get the best out of your Canon EOS D-SLR 
and lenses, and to get wildlife shots a pro 
would be proud of!  

Lenses for Wildlife

Ill
us

tr
at

io
ns

 A
nd

y 
M

cL
au

gh
lin

Page 36 Page 38

With Ben Hall

super-TeLephoTo 
prime Lenses

With Alex Hyde

maCro  
Lenses

page://36
page://38


32  |  PhotoPlus Xxx 2012

Canon Lens Skills Series

32  |  PhotoPlus April 2015

Ph
ot

os
 S

te
ve

 B
lo

om

WIDe-aNgLe LeNSeS

Go wide to capture 
perspective

We see giraffes as 
being very tall, but 
they are also tiny 

against the wider landscape. 
It would be a fairly natural 
reaction to reach for the 
longest lens possible when 
such a creature appears far off 
on the horizon, but the sky was 
so inspiring that I used the 
widest lens I had in my bag.  
The sky looks like it is about to 
crush the giraffe, and the use 
of the wide-angle lens in this 
case shows the fragile nature 
of life on the African plains.

Emphasis 
vulnerability

Pandas are often photographed up 
close but seldom in their habitat. 
Using a shallow depth of field is 

not usually associated with wide-angle 
shots, but here a wide aperture ensures 
the background is slightly blurred, 
so while the surroundings are strongly 
evident to give a sense of depth, the eye 
is drawn to the sharply focused panda. 

Lens: Canon EF 16-35mm f/2.8L USM 
exposure: 1/250 sec at f/16; ISO100

Focus attention 
on the subject 

Lens: Canon EF 16-35mm f/2.8L USM 
exposure: 1/500 sec at f/3.5; ISO100

Steve is a prolific Canon 
professional wildlife 
photographer who’s won 
numerous high-profile 
photographic awards 
and authored several 
brilliant photography 
books. More info at www.
stevebloomphoto.com

steve bloom

Wide-angle lenses are often under-used in 
wildlife photography, yet present a huge scope 
for creativity, and give the viewer a greater 
sense of perspective because they accentuate 
the size difference between near and far 
subjects. Think laterally, and consider the 
animal’s place in the surrounding landscape. 
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Wide-angle Lenses

Get a fisheye view

This enormous bull elephant swimming in 
the Andaman Sea was photographed 
handheld with a fisheye lens in a Subal 

underwater housing. Water becomes more and 
more opaque the further the subject is in the 
distance, so it is only possible to see the elephant 
in any detail when it is very close. The refractive 
properties of water also make the elephant look 
further away than it is, and reduce the extreme 
wide angle look normally associated with 
a fisheye lens. The short focal length and 
buoyancy of the water means it’s possible to 
shoot with a relatively low shutter speed while 
still retaining a good degree of sharpness.
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Shoot from down low

When photographing with telephoto lenses, it is usually 
necessary to shoot from a high elevation. However, the 
opposite can be true with wide-angle lenses. Here, the 

low angle gives a sense of the majesty of elephants, showing their 
sheer dominance in the landscape. This was achieved by using a 
periscope attachment on the eyepiece, enabling my Canon D-SLR 
to be lowered to just above ground level. 

Lens 
options

Fast, wide-
angle lenses 
are more 

expensive than 
those with narrower 
maximum 
apertures, as lens 
manufacturers 
struggle to achieve 
good quality at the 
edges, with 
deficiencies 
becoming apparent at 
wide apertures. I use f/2.8 lenses, but lenses with apertures of 
f/4 or narrower are fine in most cases, as you seldom shoot at 
maximum aperture. For crop-sensor Canons, the Sigma 
10-20mm f/3.5 EX DC HSM offers great value.  

Lens: Canon EF 15mm f/2.8 Fisheye
exposure: 1/30 sec at f/11; ISO100

Lens: Canon EF 16-35mm f/2.8L USM 

exposure: 1/100 at f/16; ISO100
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A 
telephoto zoom is ideal for 
photographing larger groups of 
animals and birds as it allows 

you to fine-tune your composition 
in-camera, rather than cropping the 
image later on. Zoom in to concentrate 
on a pattern, or out to ensure that none 
of your subjects are chopped off at the 
edge of the frame. Flocks and herds 
often move around, but with a zoom lens 
you’ll be able to continually change focal 
length to keep them all in the frame.

Flocks and herds

A fast telephoto zoom with quick AF is essential 
for shooting wildlife. A 70-200mm is ideal for 
larger animals, while longer 70-300mm and 100-
400mm zooms excel at a wide variety of subjects

teLePhoto zoomS

the versatility of  
a telephoto zoom

Lens: Canon EF 70-300mm f/4-5.6L IS USM 
exposure: 1/15 sec at f/20; ISO200

Lens: Canon EF 70-300mm f/4-5.6L IS USM 

exposure: 1/320 sec at f/22; ISO400

Shot handheld by using AI Servo AF 
mode and panning left to right (using 
IS Mode 2) as the leopard passed by
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A pro wildlife, landscape 
and travel photographer 
of over 15 years, Guy runs 
photo workshops and is 
the author of 100 Ways to 
Take Better Nature and 
Wildlife Photographs. 
www.guyedwardes.com

Guy edwardes

http://www.guyedwardes.com
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Telephoto zoom Lenses

Focus closer

When it comes to close-up photography 
the versatility of a telephoto zoom 
can be increased with the addition of 

extension tubes. These cost-effective accessories 
will allow your lens to focus much closer, enabling 
you to fill the frame with much smaller subjects, 
such as flowers and insects. There is very little 
effect on image sharpness, as the tubes contain 
no optical elements. A set of three Kenko 
extension tubes, at 12mm, 20mm and 36mm, 
represents a practical and cost-effective choice. 

Wildlife within its environmentLens: Canon EF 70-300mm f/4-5.6L IS USM 
exposure: 1/500 sec at f/16; ISO1600

Blow out the 
background

Most telephoto zoom lenses 
lack the extreme focal length 
and wide aperture of the big, 

fast super-telephoto prime lenses 
often used for wildlife photography. 
This can make it tricky to achieve a 
nicely diffused background that 
makes your subject stand out. To help 
overcome this it’s important to shoot 
at 300mm from a low angle and at a 
wide aperture when possible. Here I 
rested the camera on the ground at 
the edge of the lake and used an Angle 
Finder C to help me compose and 
keep the horizon level.  

Lens options

If you regularly shoot in low light then  
EF 70-200mm f/2.8L IS USM is the 
obvious choice, as its wide aperture 

can sometimes save the day. However, 
the lower cost and reduced size and 
weight of the EF 70-200mm f/4L 
lenses make them very appealing. The 
added versatility of the EF 70-300mm 
f/4-5.6L should also be considered, as 
this is also a very sharp lens. The 
optical quality, focal range, focusing 
speed and close-focusing capability of 
the new 100-400mm f/4.5-5.6L II 
make this a great all-round telephoto 
zoom for wildlife photography. On a 
crop-factor camera body it may be the 
only telephoto lens you’ll ever need!

Lens: Canon EF 70-300mm f/4-5.6L IS USM 
exposure: 1/1000 sec at f/5.6; ISO800

Lens: Canon EF 70-300mm f4-5.6L IS USM exposure: 1/15 sec at f/11; ISO100It’s not always 
necessary for the 
subject to be big. 

Consider using the 
70mm end of your lens 
and including some of 
the surroundings to 
show wildlife within its 
natural habitat. The 
subject itself can be 
small in the image 
while still acting as a 
prominent focal point 
and providing a useful sense of scale within the 
wider environment. A telephoto zoom lens also compresses perspective, 
ideal for pulling distance mountains closer to your wildlife subjects. Plus you 
can always quickly zoom in the instant something interesting happens!
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Use predictive focus

Use a wide aperture

When capturing a portrait image, it 
is important to eliminate anything 
distracting from the frame. A lens 

with a long focal length, such as 500mm, is 
the perfect choice in such situations, as it will 
naturally produce a shallow depth of field. This 
is especially apparent when combined with a 
wide aperture like f/4. This combination can be 
used as a creative tool, helping you to isolate 
your subject from its surroundings. Including 
some surrounding foliage in the foreground is a 
great way of creating a feeling of depth and 
intimacy, especially when it’s well out of focus.
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Due to the shy nature of most wildlife, a long telephoto prime, 
such as 500mm, is imperative for capturing subjects in their 
natural habitats. Flawless image quality and speedy autofocus 
make it perfect for capturing wary birds and mammals.

super-telephoto 
for super quality

Lens: Canon EF 500mm f/4.5L USM 
exposure: 1/500 sec at f/4.5; ISO640

The best method of capturing a moving 
target, such as a bird in flight, is to use 
the predictive focusing mode and a 

apply a smooth panning technique. Use AI 
Servo AF and keep the AF point on the bird or 
animal and, if your camera allows, expand the 
focussing area to give you a better chance of 
holding focus. The Canon 500mm has two 
image stabilisation modes; Mode 1 eliminates 
all movement, while Mode 2 corrects only 
horizontal movement, which is useful when 
panning from side to side.

Ben is an award-winning 
wildlife photographer and 
has been professional 
for the past 12 years. Ben 
is a regular contributor 
to PhotoPlus, and also 
runs wildlife photography 
workshops. www.benhall 
photography.com

ben hall

http://www.benhallphotography.com
http://www.benhallphotography.com
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Prime Lenses

Lens: Canon EF 500mm f/4L IS USM 
exposure: 1/800 sec at f/4; ISO250

Rather than getting as 
close as possible to your 
subject, try shooting 

from a distance and including 
some of the surrounding 
landscape in your images. 
Often, pictures that show the 
subject in context hold far more 
interest than a frame-filling 
portrait, and can be used to tell 

a story. It is still important that 
your subject is easily visible 
within the composition, so try to 
position the bird or animal 
against a diffuse area of 
background. For this shot I used 
a mid-range aperture of f/9 to 
ensure I had enough depth of 
field at 500mm for the entire 
flock to be in focus.

Keep your distance

Lens options

Super-telephoto prime lenses 
don’t come cheap. The Canon 
EF 500 f/4L IS USM is a 

top-quality piece of glass for wildlife, 
but if you can’t stretch to its £6,900 
asking price, there is a more budget-
friendly alternative in the form of the 
Sigma 500mm f/4.5 EX DG HSM, at 
£3,800. The maximum aperture is 
not quite as wide as the Canon and it 
lacks image stabilisation, but it is still 
a sharp and fast lens that is well worth 
a look. Alternatively, it’s worth hiring 
such lenses for occasional use.  

Composition and camera-shake

The easiest and most effective composition trick is to apply the rule 
of thirds. Imagine two horizontal and two vertical lines splitting the 
frame into nine equal parts. Placing your subject on one of the 

intersecting points can instantly create a visually balanced and effective 
composition. Also, when using telephotos, use a fast enough shutter 
speed to combat camera shake. Aim to at least match your focal length 
– eg over 1/500 sec for a 500mm lens. Also use IS if your lens has it!

Lens: Canon EF 500mm f/4L IS USM 

exposure: 1/800 sec at f/4; ISO250

Lens: Canon EF 500mm f/4.5L USM  
exposure: 1/400 sec at f/9; ISO100
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Even at narrow apertures, depth of 
field is limited in macro photography, 
making precise focusing essential. 

Switch to manual focus and use Live View 
to check your subject is in focus. For fine 
adjustments, zoom in using the x10 
magnification view to see every last detail 
come into focus as you rotate the focusing 
ring. Additionally, while still using Live View, 
hold down the Depth of Field Preview 
button to see exactly what will be in focus in 
the final shot. In this photo of a chameleon’s 
tail, shot at f/22, it was important that the 
whole subject was sharp to create an image 
with strong, graphic impact.

Be careful with 
your focusing

A 100mm macro lens will give any wildlife photographer eyes into 
an otherwise unseen world. This class of lens is a must for anyone 
interested in shooting close-ups of insects and flowers, offering 
a magnified view images that really are larger than life…

maCro LeNSeS

reveal a hidden 
world in close up

Don’t just think about shooting 
landscapes at sunrise and 
sunset; your macro photos will 

also benefit from dramatic golden light. 
From August to September every year, 
vast areas of moorland in the Peak 
District in Derbyshire are carpeted in 
purple heather. For this shot I went in 
close, shooting straight into the setting 
sun to backlight the heather. The wide 
aperture has ensured the sun appears  
as a large disc in the image, creating a 
dramatic backdrop.

Dramatic lighting

Lens: Canon EF 100mm f/2.8L Macro IS USM  

exposure: 1/400 sec at f/2.8; ISO1000 
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Alex is a pro natural 
history photographer 
who travels to far-flung 
tropical forests all over 
the world. He lectures 
at the University of 
Nottingham, as well as 
running photo tours and 
one-to-one workshops. 
See www.alexhyde.co.uk 

alex hyde
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Lens options

Amazing 
abstracts

The Canon EF 100mm 
f/2.8L Macro IS USM gives 
razor-sharp results. It has a 

convenient working distance for 
most subjects; not so close that 
you cast a shadow over them but 
close enough to be able to reach 
in and move 
distracting 
blades of 
grass. The 
Canon MP-E 
65mm f/2.8 
1-5x Macro  
is great for 
close-up 
portraits of 
insects, 
zooming from 
x1 life-size all 
the way up to x5 
life-size (filling 
the frame with 
a grain of rice, for 
example). A longer 180mm focal 
length macro lens is the perfect 
choice for photographing skittish 
subjects, as the longer working 
distance will mean you are less 
likely to disturb them.  n

The limited depth 
of field of macro 
photography can 

create beautiful abstracts. 
This was captured with the 
Canon MP-E 65mm, which 
is like a microscope and 
capable of extreme 
close-ups. By using a wide 
aperture of f/3.5, the bright 
colours and repeating 
patterns of this mullein 
moth caterpillar have 
formed a striking abstract. 
The super shallow depth of 
field has been further 
accentuated by shooting 
down the length of the 
caterpillar. To freeze the 
movement of the 
caterpillar and avoid any 
camera shake, I used an 
off-camera flashgun.

Get down low to capture intimate 
portraits of invertebrates at their 
eye level. To photograph this female 

nursery web spider carrying her egg sac, 
I rested the camera directly on a piece of 
level ground. By shooting at ground level, 

the background is easily thrown out of 
focus, creating a cleaner portrait. With 
careful positioning, your camera can be 
very stable on the ground and if you also 
use a cable release you will avoid jogging  
it when you fire the shutter. 

Shoot at eye level for creepy-crawly shots

Lens: Canon EF 100mm f/2.8 Macro USM 
exposure: 1/200 sec at f/22; ISO400

Lens: Canon EF 100mm f/2.8 Macro USM 
exposure: 1/200 sec at f/5; ISO100

Lens: Canon MP-E 65mm f/2.8 1-5x Macro 
exposure: 1/125 sec at f/3.5; ISO100
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welcome...

Photography isn’t always about 
capturing what you see in front of 
you with your own eyes, and this 

issue we’ve got some great projects to 
prove it! in the first, we show you how to 
paint geometric light structures using 
a string of fairy lights and a bicycle wheel; 
a long exposure transforms a few simple 
streaks into a cool, glowing dome. in our 
second project we turn wisps of smoke 
into a beautiful dancing figure – and the 
Photoshop skills you need to achieve this 
are simpler than you might think!

Continuing the theme, in this month’s 
Masterclass we head out at the crack of 
dawn to capture a stunning sunrise and 
transform it into a ‘time stack’ – this twist 
on time-lapse photography shows the 
passage of time in a single frame and is 
great for showing off incredible skies. we 
also have the final chapter of our teach 
Yourself Photoshop CC series, showing you 
Photoshop’s more advanced tools. 

PhotoShoP ElEmEntS/CS/CC
the latest versions of Photoshop elements, 
Cs and CC have significant differences 
from previous versions, with a redesigned 
interface and major changes to the way 
adobe Camera raw works. we are now 
producing most of our tutorials with these 
newer versions, and while it’s possible to 
follow the lessons in older versions with a 
little adaptation, we recommend upgrading. 

maStErClaSS ProjECt 

BonuS vidEo! ProjECt

BonuS vidEo!

BonuS vidEo!
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Online videO  
To view our videos, click on the 
‘Watch the Video’ 
badges  that 
appear 
alongside the 
tutorials.

watch
the videO

http://bit.ly/PP_98
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Photoshop Elements

Create a glowing dome of light using a string of 
fairy lights, a bicycle wheel and a long exposure…

Paint with light!

What you’ll need
• A tripod • Standard zoom (such 
as a kit lens) • Fairy lights • Tape 
or cable ties • Bicycle wheel and 
axle • Photoshop Elements 

How long it’ll take
Half a day

The skills you’ll learn 
 How to paint with light  
 How to create a light dome 
 How to process your shots

ChecklistL ight painting is an increasingly 
popular technique in night 
photography, and you can achieve 

some truly spectacular results without 
the need for fancy kit. It’s also 
surprisingly simple to do, and the 
creative possibilities are endless, 
offering hours of fun experimenting. 

So what, exactly, is light painting? 
Essentially, an image is created by 
moving a light source during a long 
exposure to achieve light trails. This 
could, quite literally, be painting in  
the air with a torch, or creating more 
complex geometric shapes, as we’ll 
show you in this project…

Creating light trails is a simple 
technique to master as you don’t 
require specific settings. The basic 

principle is to shoot in the dark and 
reduce the amount of light entering the 
camera to enable you to shoot long 
enough exposures to record the 
movement of your lights, so you’ll need 
to set a narrow aperture and a long 
shutter speed of several seconds.  
All you need is a tripod to keep your 
camera steady and some kind of light 
source. Something as simple as 
spinning some fairy lights – or even a 
torch in front of the camera – will create 
some effective light trails. 

Once you’ve mastered the basics 
you can create more complex light 
paintings. With the aid of a few tools and 
a little bit of DIY, in this project we’ll 
show you how to make and shoot a cool 
light dome. Let’s get started!  

Your guide
Hollie Latham

PROJECT
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Build a dome of light 
To create the dome you’ll need an old wheel – 
a bicycle wheel works well – set on an elongated 

axle so the wheel slants at 45 degrees. Then get a set 
of fairy lights and attach them to the circumference of 
the wheel using tape or cable ties. Make sure they don’t 
sit along the rim edge as the wheel needs to be spun 
freely to create the dome effect.

Support your D-SLR 
A tripod is essential for this shoot as you’ll be 
shooting long exposures, and it’s vital that your 

camera is fully supported so it remains still for the 
duration of your exposure. For full control over your 
exposure settings set your camera to Manual mode. 
Ensure your camera is set to record in Raw and select 
a low ISO, ideally 100-200, for the best-quality images.

Camera settings 
There’s no right or wrong camera settings to use, 
it depends on how dark your surroundings are, 

the subject, and speed of the moving lights you’re 
shooting. We shot our dome indoors and set a narrow 
aperture of f/22 to reduce the amount of light entering 
the camera. When you’re ready to shoot, experiment 
with the shutter speed; start with a couple of seconds.

Compose and focus 
When composing your shot make sure you allow 
for enough space around the dome by spinning 

the wheel to ensure it stays within the frame. Autofocus 
on the wheel and then switch your lens to manual focus 
to lock it in place. It’s easier to do this with the lights on, 
but if you’re out at night, shine a torch on your subject. 

Start shooting 
When you’re ready, switch off the lights and spin 
the wheel gently to get a slow revolution going (an 

assistant is helpful here). Fire the shutter using a cable 
release or set the 2-sec Self-timer mode for hands-free 
shooting to keep movement to a minimum. If the dome 
hasn’t formed fully, set a longer exposure; if your image 
appears overexposed, reduce the exposure time.

Edit in Raw 
Open dome_start.dng into ACR. Set the Temperature 
slider to 4700 to cool the white balance and set the 

Tint to -13 to fine-tune the colour. Boost Highlights to +15 
and reduce Whites to -45. Set Blacks to -50 to darken the 
surroundings. To boost colour of the dome increase 
Vibrance and Saturation to +15. Click Open Image. In the 
main editor, grab the Burn tool and set Range to Midtones 
with an exposure of 25% and darken edges of the dome.  n

Temperature slider
You can adjust the 
white balance of your 
image by setting a 
custom colour 
temperature using  
the Temperature slider 
in Raw processing 
software. Move the 
slider to the left to cool 
the tones, or move to 
the right to warm the 
tones of the ambient 
light. It’s a quick way to 
add colour to an image 
like this without the 
need for taking your 
image into Photoshop. 
You can also fine-tune 
the colour by adjusting 
the tint slider to add 
green or magenta.

Phrase Book

Your exposure 
time will vary 

depending on what 
you’re shooting and 
the ambient light 
conditions. For this 
project here we 
experimented with 
shutter speeds 
between 1 sec and 15 
secs, but should your 
exposure require more 
than 30 secs, you’ll 
need to set Bulb 
exposure mode.

Super Tip!

Download project files at: http://downloads.photoplusmag.com/pp98.zip

mailto:?subject=PhotoPlus%2098%20project%20files&body=Simply%20forward%20this%20email%20to%20your%20computer%20and%20click%20the%20link%20to%20download%20the%20project%20files:%20http://downloads.photoplusmag.com/pp98.zip
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Manage your colours 
Go to Edit > Color Settings. In the Color Settings window, 
choose an appropriate location-based profile such as Europe 

Prepress 3. This will ensure Photoshop uses a print-friendly colour 
space called Adobe RGB (1998) instead of the default sRGB one. 
Leave the Profile Mismatch boxes ticked.

Convert the embedded profile 
Open print_start.jpg. The embedded colour profile of this 
image describes its colours using the screen-friendly sRGB 

colour space. You can change the sRGB profile to a printer-compatible 
one by ticking the ‘Convert document’s colors to the working space’ 
button. Click OK to close the dialog box.

Produce perfect colour prints of your photographs by 
optimising Photoshop’s colour space for printing

Convert images from RGB to CMYKSTEP BY STEP

After processing a photo to look good on screen, you 
may end up with a print that suffers from shifts in 
colour. The discrepancy between the screen and 

print colour is caused by a variety of factors. Your 
computer’s screen produces millions of colours by mixing 
reds, greens and blues (RGB) together, while most domestic 
printers combine cyan, magenta, black and yellow (CMYK) 
inks to create a narrower range of colours. Colours that can’t 
be printed are referred to as ‘out-of-gamut’ colours.

In this tutorial we’ll demonstrate how to prepare a picture 
for print and avoid colour-related disappointments. By 
default, Photoshop uses the screen-friendly colour space 

called sRGB (standard RGB). You can change this colour 
space to a narrower, more printable one called Adobe RGB 
(1998) that helps you reduce the number of out-of-gamut 
colours. There’s also a handy gamut warning that you can 
summon to identify unprintable colours.

We’ll show you how to set up Photoshop’s colour 
management tools so that you can convert files that have 
an unprintable sRGB colour space to the printer-compatible 
Adobe RGB (1998) colour space. We’ll also demonstrate how 
to change Photoshop’s colour mode so it’s compatible with 
the printer’s CMYK ink-mixing technique, so that your 
images have a vibrant, printable range of colours.

Your guide
George Cairns

Download project files at: http://downloads.photoplusmag.com/pp98.zip

Prepare your 
photos for print

waTCh
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Gamut warning 
To discover remaining unprintable colours, choose View > 
Gamut Warning. Problematic colours will appear as patches 

of grey. You could use a Vibrance adjustment layer to reduce the 
saturation of the colours. The gamut warning patches would 
vanish, but other colours may look a bit drab.

Change the mode 
Go to Mode and choose CMYK Color. Click OK. This forces 
the colours into a print-compatible CMYK colour space. 

The gamut warning patches will vanish. Choose Mode > RGB Color. 
You can now use a Vibrance adjustment layer to boost the saturation 
without producing warnings. n

Photoshop CC
Get the entire 50-part  teach Yourself photoshop  ipad video app! http://bit.ly/typsapp

http://bit.ly/typsapp


50  |  PhotoPlus April 2015

Skills Smoke trails project

PROJECT

Place incense stick 
Begin by setting up a dark background to shoot 
against (such as a blanket). Position the incense 

stick in front, then set up your camera. You don’t have 
to use a tripod, but it makes things more convenient. 
Focus on the incense stick then switch your lens to 
manual focus to prevent hunting between shots.

Position your flash 
Place your flash behind the incense and off to one 
side, and angle it so that the light is directed away 

from the background and back towards the camera. 
Set the flash to Slave mode, so that you can trigger it 
with your pop-up flash (if your camera is a model with 
no built-in flash, you’ll need to use a wireless trigger).   

Capture smoke trails then mould them into 
smoky art with simple Photoshop skills

Make   
smoke dance!
What you’ll need
• D-SLR with pop-up flash (or 
radio flash trigger) • Speedlite 
• Incense stick • Dark background 
• Tripod • ‘Flag’ (we used a 
blackboard) • Photoshop CS3 
or above 

How long it’ll take
Two hours

The skills you’ll learn
  How to photograph  
smoke by backlighting it

  How to fire a Speedlite off-
camera with your pop-up flash

  How to combine and reshape 
smoke into a figure shape

Checklist

It’s all smoke and no mirrors…STEP BY STEP

Smoke forms beautiful organic shapes, making 
it the perfect subject for a creative home 
project. Here we’ll show you how to shoot your 

own silky smoke images, then blend and transform 
the smoke into different shapes using simple 
Photoshop commands. We’ve chosen to make a 
smoky dancer here, but you could use any shape you 
like as a template for your own creations.

If you want to skip the shooting part and move 
straight on to the Photoshop technique, we’ve 
provided a great selection of smoky images for you to 
experiment with. But it can be more rewarding to 
shoot your own. The challenge, when shooting smoke, 

is to get it to stand out from the background. To do so, 
we need to make the background as dark as possible, 
and then light the smoke from behind. So as well as an 
incense stick, you’ll also need a dark blanket for the 
background and a Speedlite that can be triggered 
off-camera. Positioned behind the incense stick and 
angled back towards the camera, the flash backlights 
the smoke, giving it a wonderful glowing quality.

Once you have a selection of smoke trails to choose 
from, you can transform the flowing white lines into 
any shape you like using simple blending mode and 
Transform controls. This is easier than it might look, 
and the results can be stunning.

Wireless Flash 
Control makes 

it easy to fire flashguns 
remotely via your 
pop-up flash. Not only 
can it trigger the 
Speedlite, it can also 
set the power level via 
an encoded pre-flash. 
If your camera doesn’t 
have a pop-up flash, or 
the flashgun isn’t 
compatible with 
Wireless Flash Control, 
you’ll need to use a 
wireless flash 
trigger instead.

Super Tip!

Your guide
James Paterson

Download project files at: http://downloads.photoplusmag.com/pp98.zip

mailto:?subject=PhotoPlus%2098%20project%20files&body=Simply%20forward%20this%20email%20to%20your%20computer%20and%20click%20the%20link%20to%20download%20the%20project%20files:%20http://downloads.photoplusmag.com/pp98.zip
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Photoshop CSXxxx xxxx

WaTCH
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http://bit.ly/PP_98
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Skills Smoke trails project

Trigger the Speedlite 
Select Flash Control from your camera menu, 
then Built-in Flash Func Setting. Select Wireless 

Func and choose the Speedlite icon. Set Manual Flash 
and set the power to 1/4 power. Pop up the flash and 
take a test shot to make sure it fires the Speedlite.

Shield the lens 
When backlighting like this, you run the risk that 
the flash will strike the front element of the lens, 

causing flare. To prevent this, you need to block the 
flash light from hitting the lens using a ‘flag’ (see Super 
Tip!). Slide it in from the side while looking through the 
viewfinder, until just before it enters the frame.

Camera settings 
Set Manual exposure mode, ISO100, aperture f/11 
and shutter speed 1/200 sec. Light the incense 

stick and start shooting. Waft or blow it gently to make 
interesting smoke trails. If the smoke looks too bright or 
dark, simply increase or decrease the Speedlite power 
via the camera’s Flash Control menu.

Make a new document 
Open Photoshop. Go to File > New and use the 
Preset drop-down and Size drop-down menus to 

choose a size for your image (we went for A4). Go to the 
Background Contents option and set the colour to 
black then hit OK. Next, grab the Move tool from the 
Tools panel. Go to the Options bar at the top and check 
‘Show Transform Controls’ and ‘Auto-Select Layer’.

Copy in a template 
Open dancer.jpg (or if you prefer, any shape of 
your own) then, using the Move tool, click on the 

image and drag it up to the tab of your black image, 
then back down into the image window to copy the 
image over as a new layer. Position it centrally then go 
to the Layers panel (Window > Layers) and lower the 
layer opacity until the dancer is only just visible.

Select the smoke 

 Open Smoke08.jpg then grab the Lasso tool from 
the Tools panel. Look for areas of the smoke that 

will match the shape we want to make. Here there’s a 
part that looks like a bit like a head, so drag around it to 
make a rough selection. Grab the Move tool again and 
drag the selected area up to the tab of the main image, 
then back down to your black document to copy it over.

Screen  
blending mode
The Screen blending 
mode works by 
multiplying the 
lightness values of the 
pixels on a layer with 
those on the layers 
below. So in effect the 
black parts of a layer 
become see-through if 
there are lighter areas 
on layers below. This 
makes the ideal 
blending mode for this 
project, as we can 
combine smoke trails 
from several images to 
build up the effect.

Phrase Book
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Blend and reposition 
Go to the Layers panel, drag the newly added 
smoke layer below the dancer layer then click the 

Blending Mode drop-down menu and choose Screen. 
Next, click the bounding box that surrounds the smoke 
layer to transform it. Rotate the layer to fit the shape of 
the dancer, using the silhouetted layer as a guide. 

Warp the shape
While transforming a layer you can right-click to 
choose different Transform options. Choose 

Warp, then drag different parts of the grid to warp the 
layer so that the smoke follows the shape of the body. 
Hit Enter to apply. Open the other smoke images 
provided and examine them for parts of the smoke that 
roughly match the shapes of the body, arms and limbs.

Make a dress
The shape of smoke03.jpg looks kind of like a frilly 
dress, so use the Lasso tool to make a rough 

selection around the area. Use the Move tool to drag it 
into the main image as before, set the blending mode to 
Screen, then use the Transform controls to reposition, 
rotate and reshape it. Hit Enter to apply.

Build it up the body
Copy in more smoke layers, using the Screen 
blending mode to combine them, and the Warp 

Transform command to reshape them. If you need to 
hide any parts of a layer, click the Add Layer Mask icon 
in the Layers panel and paint black to hide the smoke in 
areas you don’t want it to appear.

Add subtle colours
When you’re happy with the shape of the smoke, 
click the Eye icon to hide the dancer layer. Next 

highlight the top layer and click the Create New Layer 
icon. Set the blending mode to Color, then grab the 
Brush tool, click the colour picker and choose a colour. 
Paint over parts of the image to colourise it, then lower 
the layer opacity until it looks right.

Tidy up rough edges
Hit Ctrl+Shift+Alt+E to merge a new layer. Go to 
Layer > New Adjustment Layer > Levels and drag 

the centre point to the left to make rough edges easier 
to see. Select the merged layer, grab the Burn tool, set 
Range to Shadows, Exposure 10% and uncheck 
Protect Tones, then paint to burn in rough edges. 
Finally, discard the Levels layer when you’re done.  n

When you 
point a flash 

towards your camera, 
just like when shooting 
into the sun, there’s a 
risk that flare will creep 
into shot. This is why it 
makes sense to ‘flag’ 
the light by using some 
sort of board or your 
hand to block it from 
hitting the front 
element of the lens. As 
you can see, it makes 
a huge difference to 
the quality of 
your image.

Super Tip!

Create geometric shapes with light See page 44

NO flag

WITH flag
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Welcome to the world’s first 50-megapixel D-SLR



Canon’s 50-megapixel monster 5DS redefines the professional D-SLR 
market with a sensor matching the power of medium-format cameras

price (RRp): EOS 5DS £3,000; EOS 5DS R £3,200 (bodies only) Available: June 2015  Web: www.canon.co.uk

the EOS 5DS and EOS 5DS R smash 
the full-frame D-SLR resolution 
record previously set by the Nikon 

D800/810. Canon’s new full-frame sensor 
offers a resolution of 50.6 million pixels 
(aka megapixels). That’s 40% more than 
the Nikon D800, a camera that caused 
jaws to drop on its own launch, just three 
years ago. To put it into perspective, the 
50Mp sensor of the new 5DS matches the 
pixel count of the studio professional’s 
medium-format Hasselblad H5D-50c 
‘digital back’ – a camera that will set you 
back a cool £22,440! It’s possible the 5DS 
will capture better fine-quality images than 

a medium-format camera, as the pixels will 
be smaller on the full-frame sensor.

Comparisons with Canon’s own EOS 
D-SLRs are even more stark. The EOS 5D 
Mark III was previously Canon’s highest 
resolution D-SLR, with 22 million pixels – 
but the 5DS more than doubles this at a 
stroke. It also makes the professional 
top-of-tree 1D X look like a baby with its 
modest 18-megapixel full-frame sensor. To 
put it another way, you could put the 1D X 
and 5D Mk III together and still come up 
10Mp short of the 5DS’s 50Mp power. 

But who really needs a 50Mp digital 
camera? This kind of resolution might be 

overkill for the average amateur 
photographer, but for professionals it 
could be crucial. It could even take away 
the need to move up to the much more 
expensive world of medium-format digital 
photography, and with the 5DS’s huge and 
incredibly detailed images, it will be 
particularly well-suited to landscapes, 
architecture, fashion and portrait 
photography. It provides the kind of 
resolution needed for large-scale displays 
like advertising billboards or posters.

While professionals are clearly the main 
target, Canon also talks about ‘personal’ 
photography. The EOS 5DS isn’t exactly 

PREVIEW!
HANDS-ON

Introducing the new 
Canon EOS 5DS…

Preview Canon EOS 5DS

WAtCH
tHE VIDEO

http://bit.ly/PP_98



The 5DS R goes on sale at the same time 
as the regular 5DS in June 2015, with a 
slightly increased price tag of £3200.

Where it fits in
It’s interesting that Canon has chosen to 
put its new sensor in the 5D body, not the 
1D line. Again, there’s a parallel with 
Nikon’s approach. The Nikon D800/D810 
is cheaper than the flagship D4s, but the 
D4s designed specifically for high-speed/
low-light sports and press photography. 
Canon’s in the same boat with the 1D X; 
that’s the specialised and expensive 
high-speed model, whereas the 5D has 
always been the more ‘affordable’ and 
smaller pro-level camera.

In fact, apart from the higher-resolution 
sensor and some external details, the 5DS 
is practically the same as the excellent 5D 
Mark III. The 5D Mark III will continue 
alongside the new models too, and not just 
as a cheaper but outdated predecessor – 
it’s better at managing higher ISO settings 
in low light, for a start. Understandably, 
as the 5DS has a more pixels, these pixels 
needs to be smaller to fit onto the 
full-frame sensor, so in turn will be more 
susceptible to noise at high ISO  

cheap, but it’s not unattainable either. It 
goes on sale from June 2015 at £3,000, 
which equals the EOS 5D Mark III’s RRP 
when it was released back in 2012 – it’s 
now available for around £2,299. And the 
5DS is still much less than Canon’s flagship 
EOS-1D X model, which was £5,299 back in 
2012 when it was launched – and is now 
available for around £4,845.

Sales of the Nikon D800/D810 have 
shown that there are plenty of committed 
enthusiast photographers out there who 
are prepared to spend serious amounts of 
money to get the best possible quality.

the 5DS R is sharper still
Canon has also followed Nikon’s lead by 
releasing the EOS 5DS R – the 5DS is the 
‘regular’ version with a low pass filter, while 
the 5D R has the low pass effect removed. 
When Nikon launched the D800 in 2012, 
it also announced the D800E. Until that 
point, all D-SLRs had an optical ‘low-pass’ 
filter in front of the sensor to prevent moiré 
(interference) effects with fine patterns 
and textures. This slightly softens some of 

the fine detail as a side-effect, and the 
D800E had the low pass filter effect 
removed (reduced actually – it was 
removed entirely for the D810).

Canon hasn’t simply taken the low pass 
filter out of the 5DS R, incidentally, since 
this would have shifted the sensor’s focal 
plane and required an internal redesign. 
Instead, the 5DS R has a second optical low 
pass filter to counteract the effect of the 
one that’s already there. The 5DS R will, in 
theory, provide slightly sharper ultra-fine 
detail, but with the possible risk of moiré 
effects with some subjects. Canon says it 
should be fine, however, for subjects with 
‘organic’ detail, like landscapes.

You might be cynical about the 5DS R. 
Isn’t the 5DS 50Mp sensor sharp enough? 
Who needs images that much sharper? 
However, the Nikon D800E proved 
surprisingly popular – people wanted that 
extra ounce of resolution, whatever the 
risk. As it turned out, nobody reported any 
moiré problems when shooting stills, so it’ll 
be interesting to see which of these two 
5DS variants proves the most popular.  

the 50-megapixel sensor is able to capture incredible fine-detail – great for big city images

12.8-megapixel sensor  DIGIC II 
processor  ISO50-3200  9 AF 

points  2.5-inch LCD 
  3fps  CF memory card 

21.1-megapixel sensor  DIGIC 4 
processor  ISO 50-25,600  

 9 AF points  3-inch LCD  
 3.9fps  Live View  HD 1080p 

video  CF memory card 

22.3-megapixel sensor   DIGIC 5+ 
processor  ISO 50-102,400 
  61 AF points  3.2-inch LCD  

 6fps  Live View  HD 1080p video 
 CF and SD memory card 

50.6-megapixel sensor  DIGIC 6 
processor x2  ISO 50-12,800  

 61 AF points  3.2-inch LCD 
 5fps  Live View  HD 1080p 

video  CF and SD memory card 

 eoS 5d 2005  eoS 5d mk ii 2008  eoS 5d mk iii 2012  eoS 5dS 2015 

Canon EOS 5D timeline the 5d line has been with us for a decade now; here 
are the major specs for each 5d incarnation…

the 5dS sensor packs in more than twice 
the pixels of its 5d mk iii predecessor

exposure: 1/125 sec at f/4; iSo800 
lens: eF 24-70mm f/4l iS uSm



Preview Canon EOS 5DS

exposure: 1/125 sec at f/8; iSo100 
lens: Canon eF 70-200mm f/2.8l iS ii uSm

the huge high-resolution 8688x5792-
pixel images need to be seen on screen  
to be believed – viewed at 100% they  
reveal macro-like close-up detail 100% zOOm



settings. Therefore the 5DS has a 
maximum unexpanded ISO of 6400, but 
the 5D Mark III goes two stops better to 
ISO25,600. The 5D Mark III is better suited 
to movies, too, because for the 5DS, Canon 
has dropped the headphone socket for 
monitoring audio levels in favour of a USB 
3.0 port for faster transfer of its huge 
image files.

Key specs
The EOS 5DS packs dual DIGIC 6 
processors (like the speedy 7D Mk II) to 
handle those massive 50-megapixel files, 
and this helps give it an impressive 5fps 
continuous shooting speed. There are 
plenty of faster cameras than this, but 5fps 
is enough for most jobs and a real technical 
achievement given the sheer quantity of 
data being captured by the sensor.

You don’t always have to shooting using 
the 50Mp 8688x5792-pixel images, as the 
5DS offers a 1.3x crop mode to simulate 
the sensor size of the older EOS 1D-series 
cameras, and a 1.6x crop mode to simulate 
Canon’s smaller APS-C consumer models. 

These still produce 30-megapixel 
(6768x4512-pixel) and 19-megapixel 
(5424x3616) images respectively, so you’ll 

still get plenty of detail – but the 1.6x crop 
mode does NOT mean that the EOS 5DS is 
compatible with EF-S format lenses. There 
are physical differences that makes this 
impossible, and the crop mode is simply 
there to simulate the smaller sensor sizes. 

This is more useful than it might sound. 
You may be used to the ‘reach’ your 
70-300mm telephoto gives you on your 
APS-C Canon, and now you can get the 
same effective magnification on the 5DS. 
You’ll also get much more manageable file 
sizes – 50Mp is brilliant, but you won’t 
necessarily need it all the time (when 
shooting JPEG, at least; with Raw files the 
full sensor data is still captured). Within the 
same crop menu, there are also three 
‘aspect ratio’ modes for more creative 
compositions; 1:1, 4:3 and panoramic 16:9.

in addition to 1.3x and 1.6x crop modes, 
three different aspect ratios are on offer

High-tech AF
The 5DS uses the same high-tech 
autofocus system as the EOS 5D Mark III, 
with 61 AF points including 41 cross-type 
sensors and five dual cross-type. It’s fast 
and powerful, though the AF customisation 
options can leave your head reeling. But 
the myriad AI Servo AF ‘Case’ settings are 
there if you need to fine-tune how the 5DS 
focuses on moving subjects. 

It uses Canon’s ‘Intelligent Tracking and 
Recognition AF’ (iTR) to track both faces 
and colour. The 150,000 pixel RG+IR light 
metering sensor also has the Flicker 
Detection first seen on the EOS 7D Mark II 
for more reliable exposures under artificial 
light (notably fluorescent light). We feel 
this is the best metering system Canon has 
produced so we’re pleased to see the 5DS 
is equally well equipped too. 

The Canon 5DS also a new Fine Detail 
picture style designed to offer advanced 
sharpness adjustment without the need for 
a computer, to help you get the very best 
out of the 5DS.

Keep it sharp
With the 5DS, Canon has introduced a new 
Mirror Vibration Control System, which 
uses cams to drive the camera’s mirror up 
and down in a controlled fashion, avoiding 
sudden stops that could jar the camera 
and blur the picture. This highlights a key 
point with the 5DS – the resolution is so 
high that small camera movements or 
focus errors that would go unnoticed in 
other cameras can start to become visible. 
The 5DS will never record less detail  

the mode dial rotates  
through 360 degrees and  
the icons are embossed

the 5dS R variant removes the low-pass filter effect for even sharper detail in images

the two variants are identical 
aside from the 5dS R’s low pass 
cancellation filter

exposure: 1/15 sec at f/11; iSo400 
lens: Canon eF 24-70mm f/2.8l ii uSm



than a camera with a lower resolution 
sensor, but you will need to take more care 
over focusing and camera shake to really 
see its full potential. 

Of course, this also means handling 
bigger image files, likely to be around 
50-60MB each. So you’ll also need to think 
seriously about getting some bigger, faster 
memory cards (it takes both CF and SD) 
and a bigger hard disk for your computer 
(or maybe a newer, faster computer) to 
handle those 50-megapixel files.

the body beautiful
The EOS 5DS is actually based on the 
existing EOS 5D Mark III. In fact, if it 
weren’t for the logos on the new camera, 
you might find it pretty hard to tell them 
apart. But that’s OK, because the 5D Mark 
III has proved itself an extremely capable, 
versatile and robust camera for 
professional stills and video photography, 
but at a price that won’t require you to 
remortgage. That Canon chose the 5D 
product line for its new 50-megapixel 
sensor rather than a top-of-the-range 
EOS-1D X refresh is good news for 
consumers too, because it keeps the price 
down to a level that could tempt well-
heeled amateurs, not just professionals. 
We are often surprised by how many 

enthusiast PhotoPlus readers use 
top-of-the-range Canon D-SLRs.

Size and weight
The 5DS is bigger and thicker than the 
average consumer D-SLR, but not by as 
much as you might expect. Serious pro 
cameras, like the 1D X, have big, fat battery 
packs integrated into the base of the body, 
which makes them both taller and heavier, 
but the 5DS uses a regular LP-E6 battery 
– the same as the 5D Mark III – which 
slides up into the grip in the normal way. 

Interestingly, this doesn’t give you as 
many shots with the 5DS – just 700 shots 

rather than the 950 shots you get from the 
5D Mark III. This suggests that the 5DS’s 
50-megapixel sensor and twin DIGIC 6 
processors are gobbling up a good deal 
more power. But even though the 5DS is 
comparatively compact (for a pro D-SLR), 
it feels solid as a rock. On the inside there’s 
a magnesium alloy chassis, and on the 
outside a hard-wearing matt finish that’s 
also easy to grip. Canon says (without the 
LP-E6 battery) the 5DS weighs 845g, 
compared to the 5D Mk III at 860g. 

externally the eoS 5dS and 5d mark iii look 
identical, but internally it’s a different story

“I was recently privileged to be given 
the opportunity as the first landscape 
photographer in the world to put the 
new EOS 5DS through its paces on an 
eight-day shoot in the Western Cape of 
South Africa. It was a fabulous 

opportunity to evaluate the 
capabilities of this impressive new 
camera, with its super-high-resolution 
50-megapixel sensor.

My initial impressions of the 5DS 
were how seemingly similar it 

was to its predecessor, the 5D Mk III, 
and this was borne out in the field. 
I was able to start working productively 
with the 5DS immediately; all the 
controls seemed very familiar, and that 
continuity was a reassurance. But I was 
very aware that, to achieve the best 
results and to make the most of the 
incredible 50Mp sensor, I had to be 
super-careful with my technique, in 
particular with focusing, depth of field 
considerations and camera stability. 
Shooting the epic coastal scenery of 
the Cape of Good Hope and the 
mountains of the interior in the 
gorgeous African light was a real treat 
– great fun, quite frankly – but I knew 
it wouldn’t be until I was able to 
process the 5DS’s Raw images and 
examine the results up close that the 
full implications of having those 50 
megapixels would become apparent.

I have to admit I was sceptical as to 
the point of this camera, I mean how 
many pixels do we really need? But the 
results banished all doubts; the fine 
detail in the images when viewed large 
is astounding. The clarity and depth 

has to be seen to be believed; images 
positively sparkle when printed large. 

Over the three decades that I have 
been a professional I have seen many 
profound technical changes come – 
and go – but one consideration all 
photographers have consistently 
grappled with is the trade-off between 
ultimate image quality and portability. 
Now we have available in the 5DS the 
versatile flexibility of a portable D-SLR 
system that’s capable of delivering the 
kind of razor-sharp image quality 
previously associated only with 
large-format photography. Couple that 
with the versatility of the Canon EF 
lens range, from fisheye to super-
telephoto, and I have to conclude the 
5DS is a real game changer.”

Exclusive Canon pro comment!
 david Noton Canon professional 

 landscape photographer 

Preview Canon EOS 5DS



Still in control
The 5DS uses the same control layout as 
the 5D Mark III, and it’s going to be familiar 
to anyone who’s used Canon’s high-end 
D-SLRs before. A trio of dual-function 
buttons on the top control six key camera 
functions – metering pattern, white 
balance, AF mode, drive mode, ISO and 
flash compensation – in the simplest way 
possible. You press the button and turn 
either the front dial or the rear dial, 
depending on which one of the two 
settings you want to alter.

For those not familiar with 5D bodies, 
the front dial is on top just behind the 
shutter release. It’s not that big, but you 
can find it straight away with your index 
finger, and it has the perfect firm, click-
stop feel. The rear dial is a large, circular 
‘dish’ that you spin with your thumb. But 
forget all of those lightweight and 
hard-to-use combined four-way controllers 
and dials you get on smaller cameras. This 
has no secondary functions you can click 
accidentally – it’s just a control dial, plain 
and simple, and it works brilliantly. 

Just above this is a small ‘thumbstick’ 
used for navigating menus and other 
on-screen options. This has a slightly 
vague feel, but it works perfectly well.

PhotoPlus: Did you use the 5DS 
crop/aspect ratio modes? 
David Noton: Yes, I experimented with 
the 16x9 aspect ratio ‘letterbox 
panoramic’ image format. When 
shooting in Raw, the images aren’t 
actually cropped, just masked; no 
information is discarded. 

PP: Or feel the need to use smaller 
m-Raw and S-Raw files? 
DN: No, I go for maximum quality all 
the time.

PP: How fast was the 5DS when 
recording files to memory cards? 
Do you need very fast CF cards?
DN: I did notice the write time was a 
bit longer than I’m used to with my 5D 
Mk III. A fast high-capacity memory 
card is definitely necessary when using 
this camera. There are dual slots for CF 
and SD cards.

PP: Did you use 5fps burst mode? 
DN: No. If fast action is your game then  
stick to the 1D X. The 5DS is a specific 
tool for the job of achieving optimum 
image quality, and as such is well 
suited to landscape photography.

PP: What was the mirror 
Vibration Control like?
DN: On the tripod I used either Mirror 
Lock-up or Live View, so it wasn’t 
a factor, but handheld the Mirror 
Vibration Control was noticeably 

smooth. It should help to reduce 
camera shake, particularly when 
twinned with Image Stabilization.

PP: What did you think of the  
5DS R low pass cancellation filter?

DN: I’ve not yet had an opportunity to 
test the 5DS R yet. Logic suggests it 
should be my natural choice for 
landscape work. It will be interesting 
to see just what difference there is 
between the two.

My main Canon EOS D-SLR is 
the full-frame 5D Mark III. It’s a 

camera I love and it’s brilliant for all 
types of photography, from 
landscapes to portraits to wildlife. 
So I was very intrigued to try out the 
Canon 5DS, as essentially it’s the 5D 
Mk III with a impressive 50Mp full-
frame sensor inside. Now, I remember 
years ago when digital cameras came 
with what-we-once-thought-were-ace 
1Mp sensors… so 50Mp to me seems 
like the moon on a stick – with cheese 
on top! However, I can see where 50 
megapixels will come in very handy 
indeed – especially when we need to 
zoom into areas of an image for pages 
when printing double-page spreads 
(A3 in size). Hefty cropping – even by 
50% – will still leave an image larger 
than those from the 22Mp 5D Mk III...

The 5DS also has various crop 
modes (1.6x, 1.3x), should you want to 
hark back to smaller, cropped (or 
magnified) images when using certain 
telephoto lenses, for instance. 
However, as some APS-C users might 
have wished for, the 1.6x crop mode 
doesn’t mean you can attach EF-S 
lenses, and perhaps this is no bad 
thing. Why would you want to attach 
basic EF-S lenses to a superior 50Mp 
full-frame CMOS sensor? It would be 
bordering on criminal not to use the 
very best EF pro lenses to make the 
most of this vast megapixel count, 
to capture the sharpest, most 
detailed shots possible!

I can’t wait to spend some more 
quality time with the new 5DS to test 
out its power and 50Mp image 
resolution properly.

EOS 5DS first 
impressions
Peter Travers PhotoPlus editor



Between them is a ‘Q’ button, which 
activates a Quick Control screen – and on 
the 5DS it’s now possible to customise the 
Quick Control screen with your own 
favourite settings within easy reach on the 
LCD. We didn’t have time to explore this 
properly, but it looks like it could be a really 
useful option for photographers who use 
their cameras all day long in their own 
particular way.

The 5DS also has the same large, 
crystal-clear 3.2in LCD for reviewing 
images and shooting using Live View 
(although in common with other top-end 
EOSs, this is neither touchscreen nor 
swivelling). If you currently use a 5D Mark 
III (and probably any other high-end Canon 
D-SLR) you could pick up the 5DS and start 
using it straight away because all the 
controls are exactly where you’re used to 
finding them.

Quiet please
The shutter sound – or lack of it – is 
striking. The EOS 5D Mark III was already 
uncannily quiet for a camera with a full-size 
mirror and shutter mechanism, but the 
new mirror control system built into the 
5DS makes it softer still. There are 
mirrorless compact system cameras that 
make more noise than this.

As we’ve said, the 5DS can’t quite match 
the frame rate of the 5D Mark III, offering 
5fps continuous shooting rather than 6fps, 
but that’s really impressive given the huge 
size of its files. Canon says it can capture 
14 Raw files in a row before the buffer fills 
up – again, very impressive – though you’ll 
need a fast UDMA 7 card for this. 

Preview Canon EOS 5DS

Tech specs 
Canon 5DS v 
Canon 5D Mk III

50.6Mp full-frame CMOS sensor

Dual Digic 6

61 (41 cross-type; 5 dual cross-type)

100-6400  
(expandable to 50-12,800)

8688 x 5792 Raw/Large JPEG 
6480 x 4320 M-Raw 
4320 x 2880 S-Raw 
6768 x 4512 1.3x Crop JPEG 
5424 x 3616 1.6x Crop JPEG 
5792 x 5792 1:1 Crop JPEG

Built-in fixed/disabled (5DS R)

252

Full HD 1080p at 30, 25, 24fps

100% coverage,  
0.71x magnification

3.2-inch 1,040K dots

Yes

5fps

510 JPEGs or 14 Raw files

Yes

USB 3.0, HDMI, External 
microphone

16

845g

£3,000 RRP (5DS) 
£3,200 RRP (5DS R) 

Megapixels 

Image processor 

AF points

ISO range 
 

Image sizes 
 
 
 
 

Low-pass filter 

Metering zones 

HD video

Viewfinder 

LCD size

LCD Live View 

Continuous shooting

Max burst 

Top LCD/rear dial  

Interface 

Custom functions

Weight (body with battery) 

Price (body only)

22.3Mp full-frame CMOS sensor

Digic 5+

61 (41 cross-type; 5 dual cross-type)

100-25,600  
(expandable to 50-102,400)

5760 x 3840 Raw/Large JPEG  
3960 x 2640 M-Raw 
3840 x 2560 M JPEG 
2880 x 1920 S-Raw/S1-JPEG  
1920 x 1280 S2-JPEG  
720 x 480 S3-JPEG

Built-in fixed

63

Full HD 1080p at 30, 25, 24fps

98% coverage,  
0.71x magnification

3.2-inch 1,040K dots

Yes

6fps

16270 JPEGs or 18 Raw files

Yes

USB 2.0, HDMI, Headphone 
mini jack, External microphone

13

860g

£2,299 street price

Canon eoS 5dS/5dS R Canon eoS 5d mk iii

The 5DS is almost identical, 
externally, to the 5D Mark III, and 
that’s a real plus point – it’s a solid, 
neat design with really well-thought-
out controls, and all of this has been 
retained in the 5DS. You lose the 
headphone monitoring socket,  
so it’s not as good for video, but 
Canon says the 5D Mark III will 
continue alongside, so videographers 
can carry on using that instead. 

But the 5DS, of course, adds that 
incredible 50-megapixel sensor with 
more than double the resolution – 
wow! The EOS 5DS and 5DS R aren’t 
out until June, but we can’t wait to 
test one properly, and we’ll bring you 
a full verdict as soon as we can.  n

Early verdict
one clever new feature is a 
customisable Quick Control 
screen, which enables you to set  
up the 5dS so you can easily 
access the controls you use most 
often via the lCd and Q button





Your guide
George Cairns

Add customisable text to enrich your creative projects
using Photoshop’s powerful typography tools

The Horizontal Type tool and its Tool 
panel compartment cousins 
enable you to enrich your creative 

projects in many ways, such as providing 
posters or book covers with eye-catching 
typography, or turning text into a key 
component of an illustration by inserting 
a photo into the fonts.

At first glance, the Type tool works in a 
similar way to word-processing packages. 
As you move the mouse onto a 

Photoshop document a text cursor will 
appear. Click to place the cursor on a 
particular spot and start typing on your 
keyboard to add text to the document as 
a new layer. You can treat this text layer 
like any other Photoshop layer, and use 
the Move tool to fine-tune the position of 
the text in the design.

As with word-processing packages, 
you can change text in Photoshop in 
a variety of ways. Double-click to select 

a word, or drag to select a few letters. 
Like shapes produced by the Pen or 
Custom Shape tools, text is created 
mathematically as vector shapes, so you 
can increase the size without making the 
edges fuzzy. You can distort text, too, 
using the Create warped text option, and 
edit the size, font or spelling of the warped 
text if need be. However, to apply other 
filters and commands you’ll need to 
convert it to a raster layer.
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Skills Photoshop Essentials

Create elaborate 
titles and captions

Download project files at: http://downloads.photoplusmag.com/pp98.zip

Get the entire 50-part  teach Yourself photoshop  ipad video app! http://bit.ly/typsapp

watCh
the video

http://bit.ly/PP_98

mailto:?subject=PhotoPlus%2098%20project%20files&body=Simply%20forward%20this%20email%20to%20your%20computer%20and%20click%20the%20link%20to%20download%20the%20project%20files:%20http://downloads.photoplusmag.com/pp98.zip
http://bit.ly/typsapp


TOOL COMPARTMENT
The Horizontal and Vertical Type 
tools function as their names 

suggest. Hold down Shift and tap T to 
cycle through the four versions of the 
Type tool in this compartment.

MARVELLOUS MASKS
The mask versions of the 
Horizontal and Vertical Type tools 

create text-shaped selection marquees 
as you type. You can then paste a copied 
photo into the layer to add texture to 
your typography.

FONT FAMILY
Click here to open the drop-down 
font family menu and then scroll 

through the dozens of options to find 
a font to suit your needs. If the text layer 
is highlighted, use the up or down arrow 
keys to change the fonts.

ALIGNMENT
If you press Enter while typing, 
you will create a new line. If you 

have several lines of text selected, you 
can click these options to align the text 
to the left, centre or right.

CHARACTER PANEL
When using the 
Typography workspace, 

you can get easier access to 
the powerful text-tweaking 
Character panel, with its ability 
to change properties such as 
the text height, width and the 
gaps between the letters.

LAYER STYLES
You can make 2D 
text look like solid 

3D shapes by adding a 
Bevel and Emboss layer 
style to the layer. This 
helped our design’s text 
look like it was carved 
from marble.

CREATE  
WARPED TEXT

This option provides 
quick ways to warp your 

text in creative ways. We used 
the Wave option to help the text 
follow the contours of the 
buildings in the image. Warped 
text remains editable.

Photoshop CC

Photoshop Anatomy: The Type tools
Get to know the key features of Photoshop’s Type tools

Choose a font for your text by clicking this 
drop-down menu [1]. You can modify 
compatible fonts to turn them into bold or 
italic versions with this drop-down menu [2]. 
Increase the value in this field [3] to change 
the selected text’s vertical scale. By 
adjusting the baseline shift [4] you can raise 
the text up or down. By adjusting the leading 
[5] you can narrow the gap between lines of 
text (or make them overlap). Adjust Tracking 
[6] to widen the gaps between the letters. 
Increase Horizontal scale [7] so that shorter 
words on one line will stretch and match the 
width of longer words on another. Click these 
icons [8] to turn lower case characters into 
capitals or underline text, for example.  n

the character 
panel explained
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How to change fonts, and 
alter your text attributes, 
with this pop-out panel
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Skills Master Photoshop actions

Checklist
What you’ll need
Tripod • Intervalometer cable 
release (or a D-SLR with built-in 
intervalometer) • Photoshop CS4 
or above 

How long it’ll take
3 hours

The skills you’ll learn
  How to shoot a sequence  
of images for a time-stack  
image or time-lapse video

  How to record an action to 
automate the blending process 

In this month’s Masterclass we’ll show you how 
to shoot incredible ‘time stacks’. To do this  
we set up our camera just as we would for a 

time-lapse, so that it takes a series of shots at 
regular intervals. Typically a sequence like this 
would then be combined into a video, showing the 
rising sun in a matter of seconds. But rather than 
do the usual time-lapse thing, we’re going to try 
something a little bit different.

Taking inspiration from the photography of 
time stack maestro Matt Molloy, we’ll combine the 
lightest parts of an entire sequence of images into 
one incredible frame. It’s exactly the same method 
you would use to combine night-time star trail 

images, but used on a sunset or 
sunrise instead it produces a 

painterly effect that 

– while unpredictable – can result in incredible 
light-bursting skies. We’ll show exactly which 
camera settings and kit you need to shoot for a 
time stack (the same shooting technique works  
for conventional time-lapses too). We’ll then go  
on to explain how to combine the sequence in 
Photoshop using the Lighten blending mode. 

Combining hundreds of frames manually would 
be a real bore, so to speed things up we’ll show you 
how to write your own ‘action’ that automates the 
task. We’ve supplied the finished action among the 
project files, but knowing how to make your own 
custom actions is a very useful skill any time you 
want to speed up monotonous tasks. What’s more, 
it’s easier than you might think and, once started, 
you can kick back with a cuppa while Photoshop 
does all the hard work for you!  

Learn how to shoot a sunrise sequence, then combine all the 
frames in Photoshop with an action to create heavenly skies

Create incredible 
time stack images

Your guide
James Paterson
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Shoot breathtaking landscapes in Scotland See page 8

WaTCH
THe video

http://bit.ly/PP_98

page://8
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STeP BY STeP

Learn how to set up your camera to capture sunrise from start to finish
Master interval shooting

Use a tripod and 
Manual focus

Set your camera up on a 
sturdy tripod and make 

sure you don’t nudge or move it 
once the interval shooting 
sequence has begun. Focus on 
your subject, then switch the lens 
to Manual focus to lock it in 
place. If you’re shooting a sunrise 
or sunset, make sure you’re in 
position and set up in good time.

Set Aperture Priority
When shooting a time-lapse of a 
sequence like this, in which the 

light levels increase as the sky 
brightens, use Aperture Priority mode. 
This way, the shutter speed will adjust 
as the sequence goes on, while depth of 
field will remain constant. Choose a 
fairly narrow aperture for good depth of 
field – we used f/11 here.

Attach an 
intervalometer

Some of the latest Canon 
D-SLRs, such as the 7D Mark II, 

have built-in intervalometers that 
enable you to set up a time-lapse 
sequence. But for most models, like 
the 6D we used, you’ll need a 
separate intervalometer, such as the 
Hähnel Giga T Pro II. Set the interval 
between shots to 5 secs or so, and 
leave it to fire continuously until you 
choose to stop the sequence.
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We critique your shots Page 80

Shoot an extra frame  
for the foreground 

When exposing for the sky in a scene like this 
the land and foreground will be very dark – if 

not totally black. If you’d like to reveal detail in these 
parts of the scene, then – once you’ve finished 
shooting the time-lapse sequence – fire off one 
more shot at the end with exposure compensation 
set to about +2. Even if you don’t end up using it in 
the finished image, it’s worth getting, just in case!  

Expose for the clouds
When shooting into the sun 
like this, it’s best to expose 

for the clouds, throwing the 
foreground into silhouette. 
To do this, set Evaluative 
metering mode and position 
your focus point over the sky 
(in Evaluative, the metering is 
weighted around the focus 
point, unlike Spot and Partial 
modes, which always use the 
central point). You can also use 
exposure compensation to fine-
tune the brightness.

Break the horizon
When shooting any scene in 
which the sunrise or sunset 

is the star, add interest to your 
composition by including a subject 
that ‘breaks’ the horizon, like the 
old diving board here. And if you’re 
stuck for a good location to try this 
technique out, look for bodies of 
water that will reflect the beautiful 
colours in the clouds.

page://80
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STeP BY STeP

Time-lapse
A time-lapse is a 
sequence of images 
shot at regular 
intervals (usually 
several seconds or 
even minutes apart), 
then put together into 
a video that shows 
speeded-up action. 
To make one in 
Photoshop (CS6 or 
above), simply go to 
File > Open, select the 
first image in your 
sequence, check the 
‘Image Sequence’ box 
at the bottom of the 
Open dialog. Hit Open 
and choose a frame 
rate, such as 30fps, 
then go to the Timeline 
panel (Window > 
Timeline) and hit the 
Play button. The 
sequence will render 
slowly. Once it’s done, 
hit Play again to view it 
full speed, then go to 
File > Export > Render 
Video… to export it.

Phrase Book

Blend with Lighten
Go to Layer > Layer Style > Blending Options and 
set Mode to Lighten. Next go to Layer > Merge 

Down to combine the layers. Hit Ctrl+~ to switch back 
to the previous document and go to File > Close. Click 
the Stop button in the Actions panel to stop recording.

Copy and Paste
When recording actions, use menus or keyboard 
shortcuts, rather than clicking icons or document 

tabs, so that commands remain universal. Hit Ctrl+A to 
Select All, then Ctrl+Shift+~ (tilde key) to switch to the 
previous document. Hit Ctrl+V to paste the layer in.

Make a test folder
To check the action is working, open another 
image, click on the action and click Play. Close the 

document without saving. Now we’ll create a second 
action to automate the task. We’ll use a dummy set of 
images to test it out, so begin by copying ten or so 
images from your sequence into a separate folder.

Record another action
Click on the New Action icon again. Call it 
‘Timestack Lighten’ and hit Record. Go to File > 

Open and open the first image in your sequence. We 
need to make a fresh copy, so go to Image > Duplicate 
and hit OK. Next press Ctrl+Shift+~ to switch back to the 
first document and go to File > Close.

Start your action 

 Open the first two images in your sequence.  
Click the New Action icon at the bottom of the 

Actions panel. Name the action ‘Copy and Close’ then 
hit Record. From now on, everything you do will be 
recorded in the action. But you can hit Stop at any  
time to pause it, and Record to continue.

Spring into action to blend frames

Make an action Set
There are two parts to our action: first we’ll record 
the technique of copying, pasting and changing 

the blending mode. Once we’ve set this as an action,  
we can automate it inside a second action. Open the 
Actions panel (Window > Actions) and click the fly-out 
menu at top right. Make sure ‘Button Mode’ is unticked 
then choose New Set. Name it ‘Timestack’ and hit OK.

 If you’d rather 
not go to the 

trouble of making your 
own action, we’ve 
supplied one for you 
(Photoshop CS5/
CS6/CC only). As well 
as time stacks, you 
can also use it to blend 
star trails. To install it, 
either drag-and-drop 
the timestack.atn file 
on an open Photoshop 
window, or go to the 
Actions panel, click 
the fly-out menu and 
choose Load 
Actions.

Super Tip!

Download project files at: http://downloads.photoplusmag.com/pp98.zip

mailto:?subject=PhotoPlus%2098%20project%20files&body=Simply%20forward%20this%20email%20to%20your%20computer%20and%20click%20the%20link%20to%20download%20the%20project%20files:%20http://downloads.photoplusmag.com/pp98.zip
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Next issue Segmented scenic shots!

Try traffic trails
The blending action 
doesn’t just work 
wonders on skies, it 
can also be used to 
merge long-exposure 
traffic trails, creating a 
vibrant mix of neon 
lines and shapes. 
Simply run the 
‘Timestack Lighten’ 
action on a folder of 
traffic trail images (all 
taken from the same 
position with a tripod) 
for amazing urban 
abstract images.

Phrase BookBuild in pauses  
Press the Stop button to stop recording. Now we 
need to ensure the action works on other image 

folders. Look at the ‘Timestack Lighten’ action and 
you’ll see little square boxes to the left of each step. 
Highlight the box next to ‘Open’ and ‘Batch’ . Now the 
action will pause at these points, allowing you to specify 
the correct image or source folder.

Try alternate files
The effect might work perfectly first time, but you 
may need to increase the interval between shots. 

To do so, simply expand your grid in Bridge, then hold 
Ctrl and drag down columns to select alternate rows 
(or every third, fourth etc). Copy and Paste the selected 
files into a new folder, then run the action again.

Boost the tones
We’ve used every sixth image here, then combined 
two versions – one for the sky, the other for the 

water – using a layer mask. To finish off, boost the tones 
with adjustment layers and any other tools you like – we 
used the Camera Raw filter, cloned out the distracting 
aeroplane vapour trails, and used the Dodge and Burn 
tools to selectively lighten and darken parts of the sky.  

Add stop messages 
We can also add messages to remind us what to 
do. Highlight the Open step then click the Action 

panel’s fly-out menu and choose Insert Stop. Type 
‘Open the first image in your sequence’, check ‘Allow 
Continue’ then hit OK. Drag the Stop step above the 
Open step in the action. Add another Stop above the 
Batch step to remind you to specify a source folder.

Automate the first action
Go to File > Automate > Batch. Choose 
Set: ‘Timestack’, Action: Copy and Close, 

Destination: Save and Close. Set Source: Folder then 
click the Choose button and navigate to your folder 
of test images. Hit OK to automate the action and 
watch as it copies, pastes and blends the layers for you.

Run the action
Now the action is ready, highlight the set then 
click the fly-out menu and choose Save Set. Close 

any open images then highlight the ‘Timestack’ action 
and hit Play. Choose the first image and specify a 
source folder, then sit back and watch the action run.

For a different 
effect, try 

blending frames using 
the Darken blending 
mode rather than 
Lighten. You needn’t 
make a new action 
from scratch; simply 
duplicate the existing 
‘Copy and Close’ 
action and replace the 
step where the Lighten 
blending mode is 
used. To do this, drag 
the step to the trash 
then hit record and 
record the process of 
changing a layer’s 
blending mode 
to Darken. 

Super Tip!

page://113
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PROBLEM #42

“You’re not left 
high and dry as 
the camera can 
guide you to the 
correct exposure”

modes can make a mess of all those bright 
lights and dark areas, and to prevent lots of 
toing and froing with test shots and varying 
degrees of exposure compensation, it’s 
often quicker to switch to Manual.

In Manual exposure mode, it’s down to 
you to set the three parameters of exposure: 
aperture, shutter speed and ISO. Thankfully 
you’re not left high and dry as the camera 
can guide you to the correct exposure. 

Exposure compensation 
doesn’t work in Manual mode. But 

you can still use the camera’s Auto 

Exposure Bracketing (AEB) to  

take three shots at different
 

exposure levels

Your EOS camera provides 
convenience and control over 
exposure when used in its semi-

automatic shooting modes. Whether you’re 
taking pictures in Aperture Priority, Shutter 
Priority or Program, you can lock the 
exposure with a dab of the ‘*’ button, quickly 
make subsequent pictures brighter or 
darker using exposure compensation, and 
then call up the brightness histogram to 
check for over- or underexposure. So why 
bother using Manual mode, where you have 
to spend time dialling in all the exposure 
settings, always with an eye on the exposure 
indicator in the viewfinder?

Simple: Manual exposure gives you 
consistency. Once you’ve settled on your 
preferred level of exposure for a scene, the 
settings stay locked in. Unless the lighting 
changes or you dramatically shift the focus 
point closer or further away, then you can 
get on with the business of composing a 
picture and waiting for the decisive moment 
without having to worry about how the 

camera’s going to expose it. This is 
particularly useful when you’re shooting 
active subjects. As long as the lighting is 
consistent on the subject, you know that it 
will be exposed well, no matter what type of 
background it’s moving past. A change from 
a dark backdrop to a light backdrop, or vice 
versa, can cause a semi-automatic shooting 
mode to shift the exposure and make the 
subject appear too bright or too dark.

Manual labour
Manual exposure is also essential for night 
photography, where the camera meter 
becomes redundant – or, 
at best, easily 
confused. Semi-
automatic shooting 

Do I really need 
Manual mode?
Manual is slow and fiddly – so is it relevant to the digital photographer?



 

STEP BY STEP

Find a midtone
Evaluative metering gives 
priority to the area within 

the AF frame; move this onto a 
midtone area, then adjust the 
aperture, shutter speed or ISO 
until the exposure indicator is in 
the middle of the scale.

You can only use Evaluative metering during Live View, so how do you take your meter readings when using Manual?

How to check the exposure during Live View
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Check the highlights
Now move the AF frame to 
a bright part of the image. 

Although the exposure remains 
the same, the exposure indicator 
has moved to the right, showing 
this area is 2 1/3 stops brighter 
than the midtone tree trunk.

Check the shadows
Repeat with a dark area. 
Again, the exposure hasn’t 

changed, but the indicator shows 
this is 1 2/3 stops darker than the 
tree, or a 4-stop difference from 
the highlights – well within the 
tolerance of the sensor.

View the histogram
Press Disp or Info until you 
reach the live histogram. 

This provides further peace of 
mind that the dynamic range of 
the scene (the histogram) fits 
within the dynamic range of the 
sensor (the horizontal axis).

When you adjust any of the parameters, 
keep an eye on the exposure indicator in the 
viewfinder or on the camera’s display. If it 
moves left, towards the ‘-’ end of the scale, 
the metered area will appear darker in the 
picture. If it moves towards the ‘+’ end of the 
scale, the metered area will appear brighter.

Alternatively, you can take an exposure 
reading in one of the other shooting modes, 

Shutter speed, aperture and ISO

make a note of those settings and then use 
those in Manual mode as a starting point.

The metering mode makes a big 
difference. With Evaluative metering, the 
entire picture area is measured and the 
camera calculates the optimum exposure – 
indicated, as always, by the centre marker 
on the exposure scale. But you don’t really 
know how it’s arrived at this exposure. For 

more precise and predictable results, use 
the Partial metering option (this acts a bit 
like Spot metering, but takes in a larger area 
at the centre of the frame, so is more 
forgiving if you find it hard to judge tone).

It’s important to develop an eye for tone 
when you’re using Manual mode. If you point 
the Partial or Spot meter at an area that’s 
approximately midtone, such as a tree  

Which should you start with when shooting 
in Manual? It depends on the subject…

For creative 
motion control, 
set the shutter 
speed first

Need to control 
the depth of 
field? Set the 
aperture first

Increase the ISO 
when you want 
to shoot in the 
dark handheld
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Manual & Auto 
ISO combined 
Handily, your camera’s Auto ISO function 
works in Manual exposure mode. This 
means that you can dial in a precise 
combination of aperture and shutter speed, 
but let the camera adjust the ISO according 
to the lighting conditions. Use this option 
when you’re shooting in low light, as you’ll 
be able to set an aperture to provide the 
depth of field you need, along with a shutter 
speed for shake-free results. As long as you 
have a sufficiently high ISO available on the 
camera, you can record a picture with this 
combination regardless of how dark it is. 
Auto ISO and Manual exposure make a great 
combination for movie shooting too, as the 
exposure will remain consistent while you 
record footage. 

In Manual mode, you decide what 
the precise combination of aperture, 
shutter speed and ISO should be. The 
thing to remember is that, when you 
adjust one of these settings, you’ll 
need to adjust one or both of the 
other settings to keep the exposure 
consistent. For example, if you close 
the aperture by one stop (decreasing 
the exposure), you’d need to either 
choose a shutter speed one stop 
slower (to increase the exposure) or set 
an ISO one stop higher. Alternatively 
you could combine the two – such as 
a shutter speed 1/3 slower and an ISO 
2/3 higher – as long as the exposure 
change adds up to one full stop.

Where do you take 
a meter reading?

Here, an exposure of 1/40 sec at f/8, 
ISO200 will render the object that’s 
being metered as a midtone in the 
image. We know this because the 
indicator is in the middle of the 
exposure scale.

To ensure the exposure is consistent 
with the original settings, we need to 
increase the exposure by one stop. 
Here, we’ve used a shutter speed one 
stop slower (1/20 sec instead of 
1/40 sec) – and the exposure 
indicator has retuned to the middle.

What if we decide that we want to 
change the aperture to f/11? This is 
one stop narrower than f/8 – notice 
how the exposure indicator has moved 
one stop to the left to show that the 
metered area will now be one stop 
darker than midtone.

Equivalent exposure

You can restrict the camera to a range of ISO 
settings in Auto ISO; for instance, you can 
prevent it from choosing the highest ISO 
settings that reduce image quality

Then you may end up 
with a picture that’s 
too dark.

Spot metering 
a bright area?

Manual mode is often used in conjunction with 
Spot or Partial metering as this provides greater 
precision when taking an exposure reading. All 
EOS cameras (apart from the 7D Mark II and 
1D X) have the Spot metering area fixed at the 
centre AF point, so first you’ll have to focus 
on the subject, then point the centre AF point 
over an area to take a meter reading and set 
the exposure, before recomposing the shot. 
As long as the lighting doesn’t change, you’ll 
only have to take an exposure reading once. 

Usually, you’ll be looking for a midtone area 
to base your exposure on, as it’s this that the 
camera meter is calibrated for. As long as the 
exposure indicator is in the middle of the scale 
in the viewfinder, you’re good to go. However, 
if the area you’re metering from is darker and 
the exposure indicator is centred, then the 
darker area will be registered as a midtone in the 
picture – and the image will be overexposed; the 
reverse is true if you meter from a bright area 
and centre the exposure indicator.



Zoom effect  
Not all zoom lenses have a consistent 
maximum (largest) aperture throughout 
the zoom range, but have what’s known as 
a ‘floating’ aperture instead. For example, 
the Canon EF 100-400mm f/4.5-5.6 lens 
offers a maximum aperture of f/4.5 at 
100mm, but by the time the lens reaches 
400mm the aperture has narrowed 
to f/5.6. The camera won’t make any 
allowance for this in Manual exposure 
mode, so remember to set the exposure 
after you’ve zoomed. If you’re lucky enough 
to have to a zoom that offers the same 
maximum aperture at all focal lengths, 
then you can zoom in and out regardless…

With many zooms, the maximum aperture 
changes as you alter the focal length
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Every month we highlight an EOS camera 
or type of lens and provide priceless 
advice to get more from your gear

5 hints and tips for...

1 Speedy glass? 
Lenses with wide maximum 
apertures relative to their 
focal lengths enable faster 
shutter speeds to be used – 
which is why they’re called 
fast lenses. The more light 
the autofocus system is 
exposed too, the better the 
AF performance, too.

2 Portrait power 
Wide apertures render 
backgrounds more out of 
focus, making fast lenses 
fantastic for portraits as 
they allow you to focus 
attention on the person 
being photographed. The 
longer the lens, the more 
pronounced the effect.

3 Focusing woes 
At wide apertures, you need 
to be dead-on with focusing; 
depth of field is so shallow 
that a slight shift of camera 
position can mean the detail 
you want to be sharp will 
appear blurred. Highlight 
the subject with a single AF 
point and activate IS.

4 Get an extension 
If you add a teleconverter 
to a lens to extend its reach, 
then you have to sacrifice 
some light; a 1.4x converter 
loses one stop, for a 2x 
converter it’s two stops. 
But fast lenses still enable 
relatively wide apertures 
and fast shutter speeds.

Fast lenses
5 Beware of flare 
Fast lenses are prone to 
flare, so fit a lens hood to 
shield the front element. 
A touch of flare can be 
welcome in some outdoor 
portraits, but ensure the 
effect is strong enough 
so that it looks intentional 
rather than a mistake.

trunk, green field or pavement, then the 
indicator should be centred on the 
exposure scale. If it’s not, change one or 
more of the exposure settings until it is. 
The trouble is, not everything’s a neat 
midtone value. Point the meter at 
something that’s darker than a midtone, 
and then centre the exposure indicator – 
you’ll find that the picture looks too bright. 
The reverse is true if you do the same with 
something brighter than midtone – the 
image will appear dark.

The reason for this is that the meter is 
calibrated so that the large marker in the 
centre of the exposure scale shows the 
position of a midtone. That darker object? 
Its exposure should be somewhere on the 

left of the scale, while the exposure for the 
brighter object should be towards the right 
(bright) side of the scale. Once you know 
this, it becomes a simple process of 
adjusting the exposure so that the 
indicator is positioned correctly. If 
you meter bright snow, adjust the 
exposure until the indicator is one 
or two stops to the right of the 
centre marker. You can always 
check the histogram and activate 
the Highlight Alert function in the 
Playback menu so that you can check 
you haven’t made any terrible exposure 
errors, but the more you use Manual 
exposure, the faster you’ll develop a feel 
for judging the range of tones in a photo.  

Make sure the 
exposure 
indicator is in  
the centre for a 
good exposure

The photo will be too bright 
if the exposure indicator is 
in the centre

Spot metering 
a midtone?

Spot metering 
a dark area?
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Is it worth using picture styles?
I’ve started shooting in Raw quality mode 
and using Photoshop Elements to process 
images. Changing between picture styles, 

like Portrait and Landscape, no longer seems to have 
any effect. Does this make picture styles redundant?
Al Brockham Leicester 

Peter says Canon D-SLR picture styles offer a 
quick and effective way of altering the image 
characteristics to suit different subjects. They 

include Standard, Portrait, Landscape, Neutral, Faithful 
and Monochrome, but only work directly on images 
when shooting in JPEG quality mode. Moreover, when 
using Basic Zone shooting 
modes, like Portrait and 
Landscape, the 
corresponding picture 
style is selected 
automatically. Shooting 
in Creative Zone modes, 
like P, Tv, Av and M, gives 
you more flexibility to 
select the picture style 
that you want to use.

CAMERA KIT

The Landscape picture 
style is a favourite for 
enhancing blue and 
green hues, while also 
making images look 
more vivid with greater 
saturation, sharpness 
and contrast 

In recent cameras, Canon has added an Auto picture 
style. This adjusts the colour tone automatically 
depending on the scene, on a shot-by-shot basis, and 
works extremely well. For full control, however, you can 
still select the various presets individually.

When shooting in Raw quality mode, each image file 
is merely tagged with the picture style option that you 
choose. The style is then applied when processing the 
file and converting it to a JPEG image in Canon’s 



Canon queries? Email us at photoplus@futurenet.com
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Quick Fix 
Disable my 
switches

When shooting 
with my telephoto 

lens, especially when 
panning, I sometimes 
change the setting of 
the AF/M, stabiliser 
on/off and stabiliser 
mode switches 
accidentally. Is there a 
camera menu option 
that will disable the 
switches? 
Don Ryder Florida

 Hollie says 
There’s no 

camera menu option 
for disabling the 
operation of the 
switches but a 
low-tech approach 
that’s often adopted is 
to stick a strip of tape 
over the switches, 
after selecting the 
desired positions. This 
avoids any accidental 
changes. Gaffa tape is 
good for this as it 
leaves no residue when 
peeled off.  

preferences, and even to create or download additional 
‘user defined’ styles. When it comes to customising 
existing styles, for example, you might want to increase 
the amount of Sharpness to make images look crisper 
(but be wary of pushing this slider too far as this will 
increase the risk of digital image noise, especially at high 
ISO settings). You can also adjust the amount of Contrast 
and Saturation, as well as altering the Colour Tone – 
increasing or decreasing the numerical value gives a 
progressively yellowish or reddish tinge respectively.

Changes to picture style settings are also useful in the 
Monochrome setting. In this case, the Saturation and 
Colour Tone sliders are replaced by Filter Effects and 
Toning Effects. Just like in film photography, the choice of 
Yellow, Orange and Red filters gives progressively darker 
blue skies with greater contrast between blue sky and 
clouds. A Green filter effect is also available, which is 
popular for enhancing skin tones in mono images.

DPP (Digital Photo Professional) program, or when 
converting to JPEG in-camera. This enables you to also 
change the picture style at the editing stage, giving more 
flexibility and meaning that it doesn’t really matter which 
style is selected when shooting. 

As you’ve noticed, picture styles aren’t supported 
when processing Raw files in ACR (Adobe Camera Raw). 
However, recent editions of the program have featured 
emulations for individual picture styles, which you can 
select by clicking the ‘Camera calibration’ tab. They’re 
fairly close to the genuine Canon picture styles for 
supported cameras, but not exactly the same.

Ultimately, selecting picture styles when shooting is 
therefore of most benefit when shooting in JPEG quality 
mode, or when you’re going to batch process Raw files in 
DPP without tweaking the settings for each image. 

Apart from using the various preset options in your 
camera, you can customise them to suit your particular 

Pick an option
The Auto picture style usually works well, 
automatically adjusting image parameters for 

individual shots. Enhancements may often fall between 
those of different preset styles, giving a particularly 
well-balanced look to pictures. Other preset options, 
like Standard, Portrait, Landscape and Monochrome, 
are available from the Picture Style menu.

Create your own
You can add to the existing range of preset picture 
styles by creating your own. Typically, there’s 

provision for adding three ‘user defined’ picture styles, 
each of which can be based on an existing preset value, 
but then customised. As shown here, select the picture 
style you want to use as a starting point, then make the 
relevant adjustments as described in the previous step.

Customise your settings
To tailor picture styles to your exact preferences, 
you can customise the individual enhancements 

for Sharpness, Contrast, Saturation and Colour Tone 
by pressing the Info button to tweak the base settings 
of all preset picture styles apart from Monochrome, 
where you can adjust Sharpness, Contrast, Filter Effect 
and Toning Effect (Sepia, for example).

Download extras
To add to your arsenal of picture styles, you can 
download new ones online from web.canon.jp/

imaging/picturestyle. They’re free to use and are easy 
to install. Connect your camera to your computer, run 
the EOS Utility program (supplied with all Canon 
D-SLRs), click on Camera settings/Remote shooting 
and then Register User Defined Style.

How to use picture stylesSTEP BY STEP

Quick Fix 
Where are my 
AF modes?

Repeatedly 
pressing the AF 

Mode selection button 
of my 70D has no 
effect. The camera is 
locked in 1-point 
Manual selection 
mode. Why is this? 
Jill Granger London 

 Angela says The 
most likely culprit 

is that the Zone AF and 
19-point Auto modes 
are disabled in the 
Custom Function 
menu (C.Fn II. 7). Go to 
this menu option and 
ensure that all three AF 
modes are ticked. See 
over the page for more 
AF trickery, when using 
AI Servo mode.

mailto:photoplus%40futurenet.com?subject=Dream%20Team
http://web.canon.jp/imaging/picturestyle
http://web.canon.jp/imaging/picturestyle
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AI Servo
The AI Servo (continuous) 
AF mode is ‘predictive’, so it 

continues to make adjustments 
even as the camera’s reflex mirror 
flips up and the shutter opens. 

What’s the best 
choice for the 
various autofocus 

settings when tracking 
moving objects?
Richard Larkins Thirsk

Adam says AI 
Servo autofocus 
usually works best, 

unless the object is moving 
directly towards or away 
from you at a rapid speed. 
Here’s our favourite setup.

What autofocus setup for panning?
EDITING SoFTWARE

Rectilinear or curvilinear?
I noticed in last month’s Dream Team that 
you recommended the Sigma 10-20mm 
f/3.5 EX DC HSM as a top choice of 

‘rectilinear’ wide-angle lens for cameras like the 
50D, with APS-C format image sensors. Can you 
explain what a rectilinear wide-angle lens is, and 
what other choices there are?
Joel Davidson Swansea

 
Angela says There are two main types of 
wide-angle lens, rectilinear being by far the 
most popular. The alternative is a curvilinear 

lens, also known as a fish-eye lens. The main difference 
is that rectilinear lenses aim to reproduce a scene with as 
little distortion as possible. Even so, there’s usually some 
outward bowing towards the edges of the frame, and this 
effect is known as barrel distortion. 

With rectilinear wide-angle zoom lenses, the amount 
of barrel distortion is typically most obvious at the short 
end of the zoom range, where the angle of view is at its 
maximum. When shooting with a curvilinear (fish-eye) 

lens, the amount of barrel distortion is much more 
extreme. The trade-off is that you can squeeze much 
more into the picture, with an extremely wide angle of 
view, often extending to a full 180-degrees in both vertical 
and horizontal planes. This is at least true of ‘circular 
fish-eye’ lenses, which produce a round photo using  
just the central portion of the camera’s image frame.

There’s another type of fish-eye lens called a ‘diagonal 
fish-eye’ but it’s often (and somewhat confusingly) also 
referred to as a ‘full-frame fish-eye’. This has nothing to 
do with whether it’s designed for full-frame or crop-
sensor cameras and, indeed, they’re available for both.  
It means that they create a larger image that covers the 
whole of the camera’s image sensor. You therefore get a 
photo that has a regular, full-sized rectangular shape. 
The angle of view is rather less, usually measuring 180 
degrees on the diagonal (between opposing image 
corners) rather than horizontally and vertically, but that’s 
still a lot more than with a rectilinear wide-angle lens of 
the same focal length, and the extreme barrel distortion 
remains clear to see.

Multi-point AF
Use Multi-point AF mode 
with AI Servo mode, and the 

camera typically uses the central 
AF point initially, but switches to 
other AF points if necessary.

Starting point
In more advanced cameras, 
like the 70D, you can set 

which AF point is used initially in 
Multi-point autofocus, to select the 
most ideal starting point.

Hollie says A 
polariser can 

make skies look 
punchier and kill 
reflections from water.

1   D-SLRs have TTL 
(through the lens) 
metering and 
autofocus, so you’ll 
need to choose a 
circular polariser, and 
avoid linear filters.

2   Low-profile 
screw-in filters are 
thinner and less likely 
to cause vignetting 
(darkened image 
corners).

3   High-quality filters 
have special coatings 
and a black finish on 
the internal surface of 
the rim, to reduce 
ghosting and flare. 

4   Screw-in filters are 
generally the most 
popular but, if you 
already use square or 
rectangular filters, it 
makes sense to add a 
circular polariser 
that’s compatible with 
your existing system.As you can see from these two example shots, both taken on a 700D, despite having the same focal 

length, a fish-eye lens has a much wider angle of view but gives far greater barrel distortion

10MM DIAGoNAl FISH-EYE 10MM RECTIlINEAR lENS

What to 
look for…
Polariser filters
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Quick Fix
Get it sharp

I’ve tried to rotate 
the dioptre 

adjustment on my 
camera so that the 
viewfinder image is as 
sharp as possible, but 
it seems really difficult 
to tell when the scene 
I’m viewing through 
the lens is at its 
optimum sharpness. 
Is there a better way 
of making the 
adjustment? 
Lucy Jackson  
Chelmsford 

 Angela says Try 
lightly pressing 

the shutter button so 
that the viewfinder 
information for shutter 
speed, aperture and so 
on are activated. You’ll 
find it easier to judge 
when the viewfinder 
image is as sharp as 
possible by viewing 
these numbers rather 
than a general scene.

I’ve been doing some night 
photography recently, but 
have found that autofocus 

sometimes misses the mark 
completely, and the viewfinder 
image tends to be quite dark. 
Can you give me any tips?
Nick Hughes Cambridge

  
Matthew says The widest 
available aperture of many 
zoom lenses shrinks from 

f/4 to f/5.6 as you go through the 
zoom range, making autofocus less 
precise, as well as giving rise to a 
dark viewfinder image, which makes 
manual focusing difficult. One 
solution is to invest in a ‘fast’ prime 
lens, which has a wider available 

aperture of around f/1.4 to f/1.8. 
This can boost low-light autofocus 
performance, as more of the 
available light is transmitted through 
the lens to the camera, and it also 
gives a brighter viewfinder image.

Another option is to switch to Live 
View. Here, the brightness of the 
scene is boosted to emulate the 
actual exposure value set in the 
camera. Another bonus is that you 
don’t have to worry about light 
entering the rear of the camera and 
having any effect on light metering, 
as the reflex mirror is permanently 
flipped up in Live View mode. Even 
so, it’s a good idea to cover the 
viewfinder to stop any chance of 
stray light leaking into the camera.  n

CAMERA SKIllS

What’s the best way 
to focus in the dark?

Manual focusing for dark scenes is much easier 
when using Live View on your LCD, especially if 
you use the x5 or x10 magnification options

I’ve got a photo backpack 
that I’ve been using for a 
few years now. It’s great 

for keeping my kit safe, but one 
thing that bugs me is that I have to 
take it off my shoulders and lay it 
down to access my camera. If the 
ground is wet or dirty, the surface 
of the backpack that I have to wear 
against my coat gets really mucky. 
Can you recommend an 
alternative side-opening  
or top-opening backpack?
Phil Thompson Caterham

 
Hollie says There are many 
recent designs of backpack that 
feature side-opening or top-opening 

access, either as full photo backpacks or as split photo 
and daypack bags with dual compartments. We’ve been 
particularly impressed by the Lowepro Transit 350 AW. 
This can be easily configured as a full photo backpack or 
as a split backpack, and it has a particularly good system 
that enables you to swivel the pack around on one 
shoulder, then remove your camera and other kit 
through a side opening. It costs around £85 to buy.

Another favourite is the  Manfrotto Advanced Tri 
Backpack Large split photo/daypack, at around £110. 

It can be worn as a backpack or in courier style as 
a sling-back. In backpack or courier modes, you can 
swing the bag around on either shoulder and get at 
your camera through one of the two openings that 
are featured on either side of the pack.

It’s easy to configure the Manfrotto Advanced Tri 
Backpack Large as a photo backpack for carrying 
a camera with a long telephoto lens attached, or 
as a split photo/daypack with side-access to your 
camera with a medium-sized lens attached

How can I keep it clean?

mailto:photoplus%40futurenet.com?subject=Dream%20Team
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Get professional feedback on your favourite photos

Tap  To view images!
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Meet our panel of experts

1 Great timing to capture this elusive 
creature in a suitably furtive 

expression and pose

2 Nicely focused to keep the subject 
sharp and blur the colourful but 

uninteresting backdrop

3 There’s too much empty space on 
the right-hand side of the frame

Photo Critique

STEP BY STEP

Behind You!

Canon EOS 1100D
Canon EF 75-300mm f/4.5-5.6 III USM
Aperture f/4.5
Shutter speed 1/200 sec

By Hayleigh Hume

Hayleigh says “I took this shot 
at the British Wildlife Centre in 
Surrey last November, as part of 

my BA Hons Photography project on 
urban wildlife. I wanted to show the urban 
fox, which is regarded as a pest by many 
people, in a more positive light, and this 
particular fox had crept out of its den to 
the frosty grass on an early November 
morning. Its dog-like mannerisms were 
comical to watch as it waited for one of 
the keepers to toss it another piece of 
chicken, and I managed to capture this 
slightly surprised-looking expression. 
I used an aperture of f/4.5 to blur the 
background, and a shutter speed of 
1/200 sec to freeze the fox’s movement.”

Peter says “This is a lovely 
candid wildlife shot Hayleigh. 
It really gives us a sense of being 

up close to this shy and elusive creature, 
and you’ve captured a wonderful pose 
and expression, as though it’s spinning 
round in surprise. The combination of 
your f/4.5 aperture and 135mm focal 
length have produced a lovely depth of 
field effect, and the fox is nicely focused 
– there’s a little motion blur in its snout 
and tail, but this adds a nice touch of 
dynamism to the shot. My only criticisms 
are that the colours and contrast are a 
little flat for what looks like a fairly bright 
day, and as the whole fox isn’t in the 
frame, and there’s too much empty 
background on the right, the composition 
feels unbalanced. I’ve used Adobe 

Camera Raw to quickly boost the colours 
and contrast – using the sliders on the 
Basic tab is quicker and easier than using 
adjustment layers in Elements’ main 
editor when you just want to make a few 
minor tweaks. Also in ACR, I’ve warmed 
up the image a little using the white 
balance Temperature slider, which 
enhances both the grass and the fox’s fur. 
I’ve then cropped the image in Elements 
to remove some of the grass on the right, 
and to finish off I’ve cloned out the matted 
fur along the fox’s back, as it’s distracting 
and spoils the animal’s sleek lines.”

SHOT
OF THE
MONTH

ACR adjustments
In Elements go to File > Open in 
Camera Raw, select the image and 
click Open. On the ACR Basic tab set 
Temperature to +5, Exposure to 
+0.40, Contrast to +20 and 
Vibrance to +20. Click Open Image.

Retouch the fur
Alt-click on a smooth area of fur on 
the top edge of the fox to sample 
those pixels, then clone over the 
matted edge fur. Clone out the rest 
of the matted fur with suitable 
pixels, then tidy up the top edge to 
remove any duplicated details that 
are noticeable.   

Crop the image
In the Expert editing workspace 
select the Crop tool, choose ‘8 by 10 
in’ from the crop menu in the Tool 
Options panel, and crop to reduce 
the empty space on the right. Add a 
new layer, select the Clone Stamp 
tool and check Sample All Layers.

How Hayleigh can enhance 
her wildlife shot in Elements

Now try this...

Peter Travers
Editor

Peter is our expert on Canon 
photography, and heads out with his 
trusty 5D Mk III at every opportunity.

Adam Waring
Operations editor

Adam fell in love with photography 
when he was a teenager, and 
specialises in landscapes and travel.

Hollie Latham 
Staff writer

Hollie enjoys shooting portraits, 
and she’s our resident expert on 
all things Photoshop.

1

2

3

mailto:photoplus%40futurenet.com?subject=Your%20Photos
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instance you could probably 
have gone a little slower and kept 
the ISO at 100, rather than 200, 
for optimum picture quality – 
there’s a little bit of colour noise 
noticeable in the shadows. 
I especially like the strong 
composition using the ‘rule of 
threes’ (not to be confused with 
the ‘rule of thirds’); odd numbers 
of subjects make a shot feel more 
balanced than even numbers. 
It’s just a shame that the wheel 
and smoke from the foreground 
plane is partially obscuring one 
of the planes in the background 
behind it – if all three planes were 
fully visible it would have made 
a great shot perfect!”  

Precise focusing and a fast 
shutter deliver a pin-sharp image

Great timing to capture Obama’s 
commanding expression

Including three planes makes 
for a balanced composition

Shooting at f/2.8 and ISO400 
gives a pin-sharp shot in low light

Well-exposed to capture detail in 
both shadows and white smoke

Audience blurred enough to add 
interest without being distracting

The composition would be better 
if all three planes were fully visible

Obama’s head slightly too low 
– position it on the top-third line

Uwe says “I’m a keen 
photographer of 
anything that flies, 

and I took this shot of the Breitling 
Wingwalkers at last year’s Royal 
International Air Tattoo at Fairford 
in Gloucestershire. I used my old 
EF 70-300mm L-series lens at 
300mm, and increased the ISO to 
200 to enable a shutter speed of 
1/2000 sec; normally I’d use a 
slower speed to capture more 
propeller blur, but I opted for a fast 
speed to ensure a sharp image.  
I used AI Servo AF mode to track 
the planes. I wanted to give the 
picture some depth by using a 
wide aperture and focusing on the 
closest plane while including two 
more in the distance.”

Adam says “This is a 
fantastic aerial action 
shot, Uwe. It’s well 

exposed and pin-sharp, but while 
it would ordinarily make sense to 
increase your shutter speed, 
given the speed of the subject and 
your 300mm focal length, in this 

Breitling 
Wingwalkers

Canon EOS 450D
Canon EF 70-300mm f/4-5.6L IS USM
Aperture f/5.6
Shutter speed 1/2000 sec

Ronald says “President 
Obama was speaking in 
Phoenix, Arizona, in 

January, and this was a photo 
opportunity I didn’t want to miss! 
I didn’t think my kit lens would be 
up to the job, so I rented the EF 
70-200mm f/2.8L. I decided to 
go with Shutter Priority (Tv) 
mode, rather than adjusting all 
the settings manually, and the 
first few shots came out so well 
that I didn’t change anything after 
that. I took about 400 photos and 
this is one of several I really liked.”

Peter says “This is 
great news portrait of 
one of the world’s most 

photographed figures, Ronald, 
and it owes much to your decision 
to rent a top-quality lens. Renting 
is a great idea if you want high-end 
kit for a special occasion, and the 
70-200mm f/2.8’s combination 

of a fast constant aperture, 
class-leading optics, and superb 
AF and stabilisation systems have 
delivered a perfectly sharp shot 
hand-held at 200mm, which 
equates to 320mm on your 
crop-sensor camera. The only 
thing I’d suggest is cropping out 
the top row of people so Obama’s 
face is on the top-third line rather 
than halfway down, or framing the 
shot to exclude those people and 
include all of the presidential seal 
on the lectern, which would put 
the face in a similar position.”

Canon EOS 500D
Canon EF 70-200mm f/2.8L IS II USM
Aperture f/2.8
Shutter speed 1/200 sec

Obama in Phoenix

By Uwe Deffner

By Ronald Morrison

Your Photos
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Steve says “This was taken at 
Marwell Zoo in Hampshire. The day 
started with brilliant sunshine, but by 

the time we got to the snow leopards it had 
turned overcast with a light drizzle. One of the 
younger leopards took an interest in my 
daughter as she peered through the fence, so 
I took the opportunity to get this shot. I’ve only 

recently started using Manual mode, and 
I adjusted the settings to compensate for 
the lighting. I don’t edit my photos – I like 
the finished image to be what I’ve shot – but 
in this case it’s in desperate need of rescuing!”

Hollie says “This is a promising shot 
Steve – it’s well composed and nicely 
focused – but you shouldn’t be 

reluctant to edit your images, and this one 
does need ’rescuing’ as it’s underexposed  
and very noisy due to the high ISO of 6400.  
At 300mm f/5.6 was the widest you could go, 
but better alternatives to cranking up the ISO 

would be to use a slower shutter speed and 
use burst mode to maximise the chances of a 
sharp shot, or zooming out to enable a wider 
aperture, then crop the shot. Luckily you shot 
in Raw mode, so we can make fairly heavy 
edits in ACR without reducing image quality – 
I’ve lightened the image and suppressed the 
noise. I’ve then used a Hue/Saturation layer to 
boost the leopard’s colours without 
exacerbating the colour noise, and blurred the 
background to remove the noise there – this 
also enhances the depth of field effect. I’ve also 
cropped the image to make the leopard’s head 
bigger in the frame.”

Canon EOS 650D
Tamron SP 70-300mm f/4-5.6 
Di VC USD
Aperture f/5.6
Shutter speed 1/500 sec

Now try this...STEP BY STEP How Steve can improve his image in Photoshop Elements

ACR edits
In ACR set Exposure to +0.80, Contrast, 
Clarity and Vibrance to +40 and 
Saturation to +20. On the Detail tab set 
Luminance to 20, Colour to 100 and 
Colour Detail to 50. Click Open Image.

Tweak the colours
Add a Hue/Saturation layer. Set 
Saturation to +10 for Reds, +40 for Yellows 
and -40 for Magentas. Invert the mask 
(Ctrl+I) and paint the effect into the 
leopard. Duplicate the ‘Background’ layer.

Blur the backdrop
Go to Filter > Gaussian Blur 
and set Radius to 6. Add a mask, and 
remove the blur from the leopard with 
a black brush. Add a Levels layer and set 
Shadows to 8 and Highlights to 240.  n

By Steve Smith
Snow Leopard

Would you like your images 
published in PhotoPlus? 
Email them to photoplus@
futurenet.com with ‘Your 
Photos’ as the subject line, 
or by post to PhotoPlus, 
Future Publishing, Quay 
House, The Ambury, Bath 
BA1 1UA. Please include 
300 words on the story 
behind your photo(s).

SEND US  
YOUR SHOTS!

*NOTE: By submitting an image you: (a) grant Future Publishing Ltd permission to publish it free of charge in the UK and foreign editions of our photography-
related magazines (print & digital), and on our photography websites; and (b) confirm that you have the right to submit the image and that Future’s use of the 
image as set out above will not infringe the rights of any person. You agree to indemnify Future against any liability it suffers as a result of using your image.

Tap  To view images!

mailto:photoplus%40futurenet.com?subject=Your%20Photos
mailto:photoplus%40futurenet.com?subject=Your%20Photos
media://leopard-1.jpg
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Issue 92 
OCT 2014
Mountain landscapes! 
Climb new heights with 
your Canon photography 
by capturing beautiful 
mountain scenes 
l Apprentice: creepy 
crawly close-ups! 
l Essential eight-page 
guide to Canon Digital 
Photo Professional 4.0 
& Irista l Super Test: 
superzoom lenses l Help 
me buy a… camera strap 
l Workshop: lens filters 
explained l Masterclass: 
shoot stunning sunsets

Issue 91 
sep 2014
Outdoor Special! Canon 
D-SLR skills to capture 
the beauty on the natural 
world l Apprentice: 
pro tips for sexy beach 
portraits l Canon D-SLR 
Starter Guide: EOS 
settings l Super Test: 
flashgun upgrades l Help 
me buy a… wide-angle 
prime lens l Workshop: 
white balance 
l Masterclass: pro-look 
head shots l Get creative 
with colour with our tasty 
photo projects

Issue 90 
Aug 2014
Capture your best 
shots of the summer 
with our easy D-SLR 
photography guides 
l Wedding portraits 
guide l Apprentice: 
shoot landmarks and 
landscapes l Super 
Test: specialist lenses 
l Workshop: dynamic 
range l Canon starter 
guide: Live View and 
LCD tips l Masterclass: 
flattering portraits of 
mature sitters l Help 
me buy a… ring flash

Buy A BInder 
fOr yOur prInT 

edITIOns!
Prefer print? Keep your mags together with our 

binder, which neatly holds a year’s issues 
www.myfavouritemagazines.co.uk/

photoplus-offers

How to get your back issues!

backissues
Catch up on what you’ve missed by 

downloading a recent issue!

Whether you’ve got an Apple 
iPad, iPhone or iPod Touch – or an 
Android, Kindle or Nook tablet – 
you can download PhotoPlus 
back issues. You can read 
on your laptop or desktop 
computer, too. To see the 
full range of devices, go 
to http://bit.ly/ppdigi 

A limited number of 
back issues of our print 
editions are available at 
http://bit.ly/ppprint

read your magazine on any deviCe:

http://www.myfavouritemagazines.co.uk/photoplus-offers
http://www.myfavouritemagazines.co.uk/photoplus-offers
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Issue 97 
MAr 2015
Lenses for landscapes – 
learn new techniques to 
quickly transform your 
shots l Apprentice: take 
colourful close-up shots 
l Master movement 
eight-page guide l Super 
Test: sturdy tripods 
l Help me buy a… sensor 
cleaning kit l Workshop: 
how the histogram can 
help improve your images 
l Masterclass: Take pro-
looking portraits at home 
l Free! Home studio 
lighting guide

Issue 89 
Jul 2014
Create your best-ever 
images with our simple 
Raw shooting and editing 
tips l Apprentice: 
capture movement 
in cars with slower 
shutter speeds l Super 
Test: travel tripods 
l Workshop: prepare 
for travel photography 
l Canon D-SLR starter 
guide: lenses and focusing 
l Help me buy a… travel 
lens l Masterclass: Shoot 
striking family profiles 
l Take top shots at a farm

Issue 96 
feB 2015
No more bad portraits! 
Camera and lens skills 
for great people pictures 
l Apprentice: the need 
for Speedlites l Buyers’ 
guide – the lowdown on 
all 152 currently available 
Canon-compatible lenses 
l Super Test: telephoto 
zooms from £100 l Help 
me buy a… canvas print 
l Workshop: get pin-
sharp shots every time 
l Masterclass: moon-lit 
landscapes l Add motion 
blur with an ND filter

Issue 88 
Jun 2014
Dawn to dusk! Get great 
shots from sunrise to 
sunset – and everything 
in between! l Apprentice: 
scuba diving with your 
SLR! l Super Test: 
camera backpacks 
l Workshop: flashgun 
skills l Canon D-SLR 
starter guide: exposure 
modes l Help me buy 
a… fast prime portrait 
lens l Masterclass: Make 
a motoring montage 
l Control depth of field 
for better wildlife photos

Issue 95 
JAn 2015
Learn to love black & 
white l Canon Gear of 
the Year – the very best 
Canon D-SLRs, lenses 
and photo accessories 
from 2014! l Apprentice: 
freeze snowboarders 
in action inside a snow 
centre l Xmas wish list 
buyers’ guide l Ultimate 
test: Canon 7D Mark II 
l Workshop: master long 
exposures l Masterclass: 
create great child portrait 
compilations l Create 
your own photo calendar

Issue 87 
MAy 2014
Canon crash course! Fix 
your photographic faults 
fast with our essential 
new D-SLR techniques 
l Canon EOS 1200D 
full test! l Apprentice: 
London’s modern 
architecture l Super 
Test: ultra-wide-angle 
lenses l Workshop: how 
to focus faster l Canon 
D-SLR starter guide: 
getting started l Help me 
buy… a gimbal tripod head 
l Masterclass: Shoot 
environmental portraits

Issue 94 
deC 2014
Depth of field made easy! 
Learn the easy way to 
control depth of field with 
our essential aperture, 
focusing and focal length 
techniques l Apprentice: 
shoot the city night lights 
l D-SLR eight-page 
buyers’ guide l Super 
Test: big telephoto zooms 
l Held me buy a… tripod 
head l Workshop: picture 
styles l Masterclass: 
shoot in the twilight zone 
l Free! Sharper shots 
mini-mag

Issue 86 
sprIng 2014
Photography road trip! 
Improve your D-SLR skills 
as we shoot Wiltshire’s 
hot spots… l Apprentice: 
take stunning scenes of 
bays and boats on the 
Cornish coast l Super 
Test: Canon D-SLRs 
l Workshop: get set 
up for spring flower 
photos l Canon D-SLR 
starter guide: Canon 
basics l Help me buy… a 
reflector l New projects: 
using ND filters l High-
speed flash photography

Issue 93 
nOV 2014
Essential D-SLR settings! 
Key Canon camera 
controls that will instantly 
improve your shots 
l Apprentice: dazzling 
dance photos l EOS 7D 
Mk II eight-page guide 
l Super Test: standard 
lens upgrades l Help 
me buy a… screen shade 
l Workshop: In-camera 
Wi-Fi l Masterclass: 
get the best from your 
lenses l Photo projects: 
brilliant mono images plus 
capture close-ups of eyes

Issue 85 
Apr 2014
Improve your Canon skills 
in just a weekend, from 
setup to exposure and 
focusing l Apprentice: 
beautiful boudoir l Super 
Test: macro lenses on 
test l Workshop: Canon’s 
in-camera HDR mode 
explained l Master 
HDR with our eight-page 
guide l Help me buy… 
a home studio lighting 
kit l 1200D hands-on 
preview l Canon and 
Sigma 24-105mm f/4 lens 
head-to-head
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Welcome...

Buy for the best 
combination of 
quality and value

Only the best of 
the best receive 
our coveted award 

Given to the kit 
you’ve used and 
rated the highest

When it comes to reviewing products and 
services in PhotoPlus, we tell it like it is. 
We’re totally independent from Canon 
and will never give someone a good score 
just because they advertise. Eyes right 
for a guide to our specific awards…

Independent advice to help you buy smarter
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The PhoToPlus  
raTings exPlained

With the launch of the new 24Mp 
entry-level EOS 750D and 760D, 
the Canon EOS D-SLR range just 

got a whole lot bigger. Back in 2004 there 
were only four EOS D-SLRs to choose from 
– the 300D, 10D, 1D Mk II and 1Ds. Now, in 
2015, there are 13 Canon D-SLRs to choose 
from; 1200D, 100D, 700D, the new 750D and 
760D, 60D, 70D, 7D Mk II, 6D, 5D Mk III, the 
new 50Mp monster 5DS and 5DS R (see 
page 55), and 1DX. The 750D and 760D 
reflect the current market; they are same 
24Mp offerings, but in two different shells 
– the 750D mirrors the beginner-friendly 
700D design, whereas the 760D follows the 
enthusiast 70D with an extra LCD on top 
displaying key settings. We give you the 
lowdown on both cameras on page 92.

Plus, in this issue’s Super Test (page 96), 
we try out eight posh telephoto zooms and 
primes – prices from £570 up to £4,450! 
And on page 88 we round up the latest kit, 
including an amazing new EF 11-24mm 
full-frame wide-angle lens from Canon,  
and the new Canon EOS M3 CSC. 

88  gear update 
Including exciting new Canon kit

92  Canon 760d & 750d 
We preview Canon’s two same-but-
different entry-level 24Mp EOS D-SLRs

96  super Test: Telephoto lenses 
Eight up-market telephoto zooms and 
primes for getting closer to the action

106  Wildlife photo kit 
Get geared up for wildlife photography

Angela Nicholson
Head of testing
angela.nicholson@futurenet.com

TelephoTo lenses 
zoom & primes
Page 96

new Canon 750D & 
760D previeweD! 

Page 92
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Gear Update

Gear Update
Our round-up of the latest digital photography must-haves

Canon PIXMA PRO-10S 
and PRO-100S
Web: www.canon.co.uk Prices: PRO-100S 
£500/€600; PRO-10S £700/€830

Canon’s excellent PIXMA PRO printer range 
gets upgraded in the shape of the new 
PRO-100S and PRO-10S, which offer new 
connectivity to enable you to print your photos 
with ease. Whether you need to print from 
cloud storage services such as DropBox,  
Flickr, Facebook, Google Drive and direct from 
Canon’s PIXMA Cloud Link, or set up to print 
via Wi-Fi, Ethernet, PictBridge or via mobiles 
or tablets, the choice is yours. The printers 
are also compatible with Canon’s new Pro 
Gallery Print app, which enables you to 
connect to cloud photo-hosting services 
Zenfolio and SmugMug from your tablet,  
so that you produce top-quality prints.

Phottix Indura500 TTL Studio Light
Web: www.phottix.com Price: £1,110/$1,199

This 500-watt studio light makes life easy because it’s got Phottix Odin 
technology built-in to give you wireless through the lens (TTL) exposure 
control from your Canon D-SLR. A high-speed sync mode enables you to shoot 
with flash at up to 1/8000 sec to freeze movement or shoot with a wide 
aperture. It’s available in a mains-powered or Li-ion battery-pack version.

Canon EOS M3
Web: www.canon.co.uk 
Price: £600/€770

The new EOS M3 is Canon’s third 
Compact System Camera (CSC), and 
inside its ergonomic body is tech 
matching the new EOS 750D and 
760D D-SLRs (see page 92). The M3 
gets the new 24.2Mp APS-C CMOS 
sensor, and Hybrid CMOS AF III and 
19-point AF System, to ensure your 
focusing is accurate via the 3in 
tilting touchscreen LCD. It’s an 
interesting back-up option, and 
although it takes EF-M lenses, 
with the EF-EOS M adaptor 
(£110) you can fit your EF-S and 
EF lenses, should you wish. 

page://92


New kit coming your way
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Canon EF 11-24mm f/4L USM
Web: www.canon.co.uk Price: £2,800/€3,700

This is the world’s widest angle rectilinear zoom lens  
and, despite the super-short focal length range, 
is for full-frame D-SLRs. You can get fisheye 
lenses that are wider, but they produce a 
strong, circular distortion effect. This EF 
11-24mm lens records straight lines as 
straight (hence ‘rectilinear’) and 
from our initial test photos it’s 
just stunning. It’s 
super-wide on a 5D 
Mk III and will be very 
useful for landscapes 
and architecture, as 
well as for tight 
interior shots. It has 
three aspherical lens 
elements, including 
one ground aspherical 
element. Full test to 
follow soon.

Canon Connect Station CS100
Web: www.canon.com Price: £199/$299

Canon’s new storage device has up to 1TB capacity for images and 
video. Images can be imported direct from NFC-enabled Canon 

cameras (like the new EOS 750D/760D) and camcorders with a single 
touch, or from a range of devices via a USB connection, directly from a 
memory card or via a Wi-Fi connection or web browser. The CS100 can 
also connect to TVs via an HDMI port for easy image viewing, or use a 

Wi-Fi connection to see them on a smartphone, tablet or computer.   

iLux V860C 
Speedlite Kit
Web: www.ilux-photographic-lighting.co.uk Price: £181/$273

iLux’s new V860C is a powerful Speedlite designed with the 
professional in mind, but with a price that will appeal to all. 
Featuring a guide number of 58 (ISO100 at 105mm), which is 
close to that of Canon’s flagship 600EX-RT Speedlite, it also 
has high-speed sync ability to 1/8000 sec. This flashgun 
already offers more than your average aftermarket flash but  
in addition there’s also full TTL, a built in transceiver and an 
internal battery pack. The pack is equivalent to the life of 16 
AAs, and spare packs can be purchased for a reasonable price.

WATCh
ThE VIdEO
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Naneu Military Ops Alpha
Web: www.naneubags.com Price: £40/$119

Naneu’s Military Ops Alpha is a mid-sized daypack with a large upper 
compartment for personal kit, and a rear-access lower section that will 
snugly fit a Canon 6D with 24-70mm, 600EX-RT flash unit and a 50mm 
lens. The front and sides feature a variety of pockets with a selection of further 
zipped pockets on the inside to keep your personal effects safe. The tough nylon fabric 
used for the exterior and padded lower section should ensure your kit stays protected, 
and there’s a waterproof rain cover, just in case of a downpour.  n 

Sandisk Connect 
Wireless Media drive

Web: www.sandisk.co.uk Price: £65-90/$79-119

The Connect Wireless is a small media device with internal storage or either 32GB 
or 64GB, ideal for storing your photographic portfolio and favourite pictures. The 
device works by wirelessly connecting to iOS or Android mobile devices and then 
images can be viewed on your phone or tablet using the free app. If you’ve been 

out on a day’s shoot then there’s an SD card slot on the side, simply slot in your 
card and use the app to navigate and view the files while out on location.

Samyang 135mm f/2 Ed UMC and 
135mm T2.2 VdSLR Ed UMC
Web: www.syopt.com/en Price: £390/$549; £430/$599

Samyang’s new 135mm lenses’ long focal lengths and wide maximum 
apertures mean they are ideal for shooting portraits and blurring 
backgrounds. While the 135mm f/2 ED UMC is intended for stills 
photography, the 135mm T2.2 VDSLR ED UMC is designed with movies in 
mind, and the decoupled aperture allows versatile control over exposure 
and depth of field. Both have 11 elements in seven groups, including extra 
low dispersion (ED) elements to improve resolution, and Samyang’s Ultra 
Multi Coating (UMC) to optimise light transmission and reduce flare. 
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We knew the entry-level Canon 
EOS 700D replacement was 
due this year, but we were 

expecting one camera, not two! Canon’s 
announcement of two new cameras is just 
one part of the story. The other is that they 
use a brand-new 24-megapixel sensor, 
made by Canon, which features the latest 
version of its Hybrid CMOS AF system.

This uses phase-detection ‘focusing’ 
pixels spread across the sensor to aid 
faster autofocus in Live View mode and 
when shooting movies. This latest Hybrid 
CMOS AF III in the 750D and 760D has 
more focusing pixels arranged in a more 
regular array, and Canon says it’s about 
four times faster than version II (used in 

EOS 750D EOS 760D

The 750D has its Mode dial on the right, like the 
100D, 1200D and 700D entry-level cameras

The 760D has its Mode dial on the left to make 
room for the top LCD, like the enthusiast’s 70D

These top views reveal two very different camera layouts…

Canon EOS 750D & EOS 760D

watCh
thE viDEO
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Price (RRP): EOS 760D £650 body only; EOS 750D £600 body only, £690 with EF-S 18-55mm f/3.5-5.6 IS STM 
Web: www.canon.co.uk Availability: April 2015

Canon releases the EOS 750D/760D D-SLR double-act. Inside they’re 
the same, but they’re aimed at two different kinds of camera novices

Canon EOS 750D  
& Canon EOS 760D

Gear Hands-on preview

haNDS-ON PREviEw



Canon EOS 750D & 760D

 the 24Mp 760D and 
750D become Canon’s 
highest resolution 
aPS-C D-SLRs, eclipsing 
the enthusiast 20Mp 
70D and 7D Mark ii    
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From bright sunshine to dark interiors, 
the new cameras will tackle all conditions

the EOS 100D) and two generations ahead 
of the original Hybrid CMOS AF system in 
the EOS 700D. The 24-megapixel sensor is 
especially interesting because this gives 
the 750D and 760D parity with rival Nikon 
D-SLRs like the D3300 and D5500. It’s also 
a sign that Canon could be pensioning off 
the venerable 18-megapixel CMOS sensor 
still used in the old 700D and EOS 100D.

The increase in resolution hasn’t 
harmed the ISO range, though, which goes 
from ISO 100-12,800 (25,600 in 
‘expanded’ mode). The processing is 
handled by Canon’s DIGIC 6 processor, 
a step up from the DIGIC 5 processor used 
in the 100D and 700D. Both cameras offer 
5fps continuous shooting and Canon’s 
more powerful 19-point AF system (all 
cross-type), compared to the 9-point AF 
on the existing entry-level models.

Round the back, they both have 
articulating 3-inch touchscreen displays 
with a resolution of 1,040,000 dots, and 
both cameras can shoot Full HD movies at 
30fps, 25fps and 24fps. They also feature 
Canon’s new Flicker Detection technology, 
first seen in the EOS 7D Mark II, for more 
reliable exposures under artificial light.

EOS 750D vs EOS 760D
So what’s the difference? It’s all about the 
body design rather than the specs and 
features. Both cameras will be part of 
Canon’s entry-level EOS lineup, but they’re 
aimed at different kinds of user. The EOS 
750D is aimed at beginners who want the 
reassurance of automatic modes and 
simpler controls of the kind they might be 
used to on a compact camera.

The EOS 760D, however, is designed for 
enthusiasts who want more creative and 
manual control. This is the one to choose 
if you already know the basics and want to 
move on. There’s little difference in the size 
and weight, but the 760D swaps the Mode 

dial over from the right side of the camera 
to the left to make room for a mono status 
LCD top-right. This displays key shooting 
information in a clearly visible way without 
the need to check the more power-hungry 
LCD on the back. Its layout is a cut-down 
design of more advanced enthusiast 
D-SLRs like the 70D and 7D Mk II. The 760D 
also has a second control dial on the rear. 
This makes changing key camera settings 
much quicker, especially when shooting in 
the semi-automatic or manual modes 
where you want to adjust the shutter speed 
and lens aperture independently.

Although the 760D aimed at more 
advanced users, the prices are not that   

With a larger 24-megapixel 
sensor, the 750D and 760D 
will help you capture more 

detail in landscape shots

Like the 700D, the 750D 
and 760D have a highest 

native ISO of 12,800  
to enable shooting in 

low-light conditions
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dissimilar. The EOS 760D will cost £650, 
body only, while the EOS 750D will cost 
£600 body only or £690 with Canon’s EF-S 
18-55mm f/3.5-5.6 IS STM kit lens. Both 
cameras go on sale from April 2015.

Canon says that they’re additions to the 
EOS range rather than replacements, and 
they are designed to slot in between the 
EOS 700D and EOS 70D.

Putting aside any potential bafflement 
over which model to buy, and why there  
are two at all, the EOS 750D and 760D do 
represent a real step forward, with a newer, 
higher-resolution sensor and much 
improved autofocus – we look forward to 
giving them the full test treatment soon.

The cameras have new Hybrid CMOS AF III 
autofocus tech for sharp and smooth 
focusing via the touchscreen LCD when 
using Live View for stills or HD videos

The Canon EOS 760D (top) is like the 
EOS 750D’s bigger brother – and aimed 

at more experienced D-SLR novices

Both the 750D and 760D are 
likely to be popular with those 

wanting to capture great 
portraits of their families

750D 760D 700D

Megapixels 24.2Mp APS-C format CMOS 24.2Mp APS-C format CMOS 18Mp APS-C format CMOS

Image processor DIGIC 6 DIGIC 6 DIGIC 5

AF points 19 cross-type (f/2.8 at centre) 19 cross-type (f/2.8 at centre) 9 cross-type (f/2.8 at centre)

ISO range 100-12,800 (25,600 expanded) 100-12,800 (25,600 expanded) 100-12,800 (25,600 expanded)

Raw quality Raw (14-bit CR2) Raw (14-bit CR2) Raw (14-bit CR2)

Max image size 6000x4000 (Raw/Large JPEG) 6000x4000 (Raw/Large JPEG) 5184x3456 (Raw/Large JPEG)

Shooting modes Scene Intelligent Auto, No 
Flash, Creative Auto, Portrait, 
Landscape, Close-up, Sports, 
SCN (Kids, Food, Candlelight, 
Night Portrait, Handheld Night 
Scene, HDR Backlight Control), 
Program, Tv, Av, Manual

Scene Intelligent Auto, No 
Flash, Creative Auto, Portrait, 
Landscape, Close-up, Sports, 
SCN (Kids, Food, Candlelight, 
Night Portrait, Handheld Night 
Scene, HDR Backlight Control), 
Program, Tv, Av, Manual

Scene Intelligent Auto, No 
Flash, Creative Auto, Portrait, 
Landscape, Close-up, Sports, 
SCN (Night Portrait, Handheld 
Night Scene, HDR Backlight 
Control), Program, Tv, Av, 
Manual

Metering zones 63 (7,560-pixel RGB+IR sensor) 63 (7,560-pixel RGB+IR sensor) 63

HD video Full HD 1080p at 30, 25, 24fps Full HD 1080p at 30, 25, 24fps Full HD 1080p at 30, 25, 24fps

Viewfinder 95% coverage, 0.82x magnification 95% coverage, 0.82x magnification 95% coverage, 0.85x magnification

Memory card SD, SDHC or SDXC card SD, SDHC or SDXC card SD, SDHC or SDXC card

LCD Vari-angle 3in touchscreen 1,040K dots Vari-angle 3in touchscreen 1,040K dots Vari-angle 3in touchscreen 1,040K dots

Top-plate LCD No Yes No

Quick Control dial No Yes No

Max burst 940 JPEGs or 8 Raws at 5fps 940 JPEGs or 8 Raws at 5fps 30 JPEGs or 6 Raws at 5fps

Wi-Fi/NFC Yes/Yes Yes/Yes No/No

Size 131.9 x 100.7 x 77.8mm 131.9 x 100.9 x 77.8mm 133.1 x 99.8 x 78.8mm

Weight (body) 555 grams 565 grams 580 grams

Body only price £600 (RRP) £650 (RRP) £470 (street price)

Tech specs
EOS 750D 
vs 760D
vs 700D
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The Canon EOS 700D was more 
evolution that revolution when it 
launched in 2013. The three real 

differences between the 700D and 650D 
were: the 700D introduced a new mode 
dial that rotated 360 degrees, it had a 
more durable external finish and it offered 
real-time previews of its Creative Filters in 
Live View mode. Let’s take a look at the key 
differences between the 700D versus the 
new 760D and 750D. 

01 Sensor and processor 
The EOS 760D and 750D feature a new 
24.2Mp CMOS sensor, an increase of just 
over 6Mp on the 18Mp 700D. So, while 
700D Raw files and Large JPEGs are  
5184x3456 pixels (43.89 x 29.26cm at 
300dpi), the maximum image size from 
the 760D/750D is 6000x4000 pixels 
(50.8 x 33.87cm at 300dpi). 

This makes the 760D and 750D 
Canon’s highest resolution APS-C D-SLRs, 
eclipsing the higher-specced enthusiast 
20.2Mp EOS 70D and 7D Mark II cameras.  

The 700D has a DIGIC 5 processor,  
the new cameras get DIGIC 6. This brings 
enhanced AF and high-ISO performance, 
although the sensitivity range, which runs 
from ISO 100 to 12,800 and is expandable 
up to ISO 25,600, is the same as the 
700D’s. This processor also extends the 
5fps continuous shooting burst from six 
Raws and just 30 JPEGs in the 700D to 
eight Raws and 940 JPEGs. 

with the familiar four-way controller seen 
on the 700D. But the 760D gets a Quick 
Control dial. This offers a convenient way 
to access exposure compensation, as well 
as navigate menus and make changes on 
the Quick Control screen. At the centre of 
the dial is a four-way pad that enables the 
white balance, autofocus mode, drive 
mode and picture style parameters to be 
directly selected. 

Additionally, the 760D gets a top-plate 
LCD, so you can quickly check the ISO, 
aperture, shutter speed, exposure 
compensation and other settings, and 
make adjustments without having to look 
through the viewfinder or check the rear 
display. This can save time and battery life.  

05 Clever viewfinder 
Both the 760D and 750D get an ‘Intelligent 
Viewfinder’ that uses a transmissive LCD, 
like the 70D, 7D/7D Mk II and 5D Mk III. 
This screen enables the focus area to be 
highlighted, in addition to the active focus 
point. The 760D also displays an electronic 
level in the viewfinder. All three Canon 
7xxDs offer approximately 95% coverage 
in the viewfinder. 

06 Metering and exposure 
All three cameras offer 63-zone Evaluative 
metering, but the EOS 760D and 750D 
uses a 7,560-pixel RGB metering sensor 
that takes colour and near-infrared light to 
determine exposures. Plus the 760D and 
750D get the latest Canon EOS scene 
analysis system. And whereas the 700D’s 
Partial metering covers 9% of the 
viewfinder and the Spot meter measures 
4%, the 760D/750D’s Partial metering 
uses 6% and 3.5% for Spot metering. 

07 hD movies 
All three cameras record Full HD 1080p 
movies at 30, 25 or 24fps. However, while 
the EOS 700D uses MOV files, the 760D 
and 750D movies are saved in MP4 format 
– the smaller file sizes making it easier to 
transfer movies and share them online.  n

Both the 760D and 750D  
now come equipped with  
Wi-Fi and NFC functionality

02 autofocus 
While the EOS 700D offers 
nine cross-type AF points (f/2.8 at the 
centre), the 760D and 750D include 19 
cross-type AF points (with f/2.8 at the 
centre). That’s the same system used in 
the 70D. The 760D and 750D also feature 
the latest Live View AF system – Hybrid 
CMOS AF III –  which provides focus 
tracking when using the rear screen. It’s 
useful for movies, enabling you to 
smoothly shift the focus point in real time 
using the Vari-angle touchscreen. 

03 wi-Fi and NFC 
In a first for the xxxD line, Canon has 
introduced Wi-Fi and NFC (Near Field 
Communication) compatibility with both 
the 760D and 750D. This enables you to 
control the camera remotely using a 
mobile device loaded with Canon’s EOS 
Remote app, to print to a Wi-Fi enabled 
printer, and the chance to share images 
and videos wirelessly to a social network. 

04 Controls 
The EOS 700D uses stainless steel in its 
construction, but the 760D and 750D 
feature aluminium alloy bodies instead. 
The new cameras show a moderate 
weight-saving: 565g (760D) and 555g 
(750D) compared with the 700D’s 580g. 
The two new cameras are almost identical 
in specification, but differ in ergonomics. 
On the rear of the 750D, Canon has stuck 

the new EOS 
750D & 760D  
vs EOS 700D
How do Canon’s two new 24.2Mp EOS D-SLRs 
compare against the older 18Mp EOS 700D?
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Bigger, better, faster. Check out the attractions 
of up-market telephoto zooms and primes and 
find out which is the right one for you…

Fast Telephoto 
Lenses Technical contributor

Matthew Richards

Gear Super Test



PhotoPlus April 2015  |  97

Buy your first Canon D-SLR kit and, 
chances are, the next lens you buy 
will be a budget telephoto zoom,  

as featured in our Super Test a couple of 
months ago (issue 96). They have a lot 
going for them, combining a typically 
compact and lightweight build with a 
wallet-friendly purchase price of between 
£100 and £400. Most also have a good 
zoom range of 70-300mm. One thing they 
all lack, however, is speed.

Budget telephoto zoom lenses tend to 
have a variable widest available aperture, 
which shrinks from f/4 to f/5.6 as you 
stretch towards the long end of the zoom 
range. All of the zoom lenses we’re testing 
this time around have a constant-aperture 
design, so the widest possible aperture 
doesn’t shrink at longer zoom settings. 
Moreover, all but one has a widest aperture 
that’s two full f-stops faster, at f/2.8, 

enabling faster shutter speeds under 
gloomy lighting conditions and a shallower 
depth of field for isolating the main object 
of interest in a composition. We’ve also 
included some fast 200mm and 300mm 
prime lenses, two of which have an f/2.8 
widest aperture. One goes wider still, being 
a full extra f-stop faster at f/2.  

Our fast telephoto contenders
1 Canon EF 200mm f/2.8L II USM £570, $775

2 Sigma APO 70-200mm f/2.8 EX DG OS HSM £750, $1,200

3 Canon EF 70-200mm f/4L IS USM £960, $1,300

4 Tamron SP 70-200mm f/2.8 Di VC USD £1,000, $1,500

5 Canon EF 70-200mm f/2.8L IS II USM £1,670, $2,200

6 Sigma APO 300mm f/2.8 EX DG HSM £2,280, $3,400

7 Sigma 120-300mm f/2.8 DG OS HSM S £2,800, $3,600

8 Canon EF 200mm f/2L IS USM £4,450, $6,000

Canon-compatible kit on test

page://84
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How we 
tested…
We tested all of the 
lenses in wide-
ranging lighting 
conditions, 
throughout their 
aperture ranges. 
However, given the 
extra cost involved 
when buying ‘fast’ 
lenses, we paid 
particular attention to 
performance at the 
widest available 
apertures. The speed 
and accuracy of 
autofocus was 
checked, along with 
the effectiveness of 
image stabilisation, 
where fitted. We also 
tested the 
smoothness and 
precision of control 
rings. Zoom lenses 
were tested at all 
focal length settings 
throughout their 
zoom ranges. Image 
quality was checked 
for sharpness, 
contrast and the 
lack of unwanted 
attributes like 
vignetting, distortion 
and chromatic 
aberrations.

Tele lenses 
great and small
There’s real diversity when it comes to size and weight

Fast glass is often big and heavy, but it doesn’t 
have to be that way. One way of keeping the 
weight off is to go for a prime lens rather than 

a zoom. As such, the Canon EF 200mm f/2.8 is one 
of the lightest and physically shortest lenses in the 
group, at 765g and 136mm. By stark contrast, the 
Canon EF 200mm f/2, which is still a prime lens but 
a stop faster, is over three times heavier at 2.52kg. 
It also has a much greater diameter at 128mm 
compared with 83mm. Why such a big difference?

The faster the lens, the more light it has to be 
able to pass through to the camera, which 
necessitates a wider diameter of diaphragm 
(aperture) and therefore a larger front element. 
Aperture ‘f/numbers’ themselves, like f/2.8 and 
f/4, are actually based on the ratio of a lens’s focal 
length to the width of the diaphragm. This explains 
why telephoto lenses with longer focal lengths 
become physically so much bigger. For example, 
the Sigma 120-300mm zoom and 300mm prime 
lenses in the group, which both give a longer focal 
length compared with the 70-200mm and 200mm 
lenses on test, yet maintain a wide available 
aperture of f/2.8, are big and weighty at 3.39kg 

and 2.4kg respectively. The 120-300mm zoom has 
a huge 105mm filter thread at the front, whereas 
the 300mm has a 46mm drop-in filter at the rear.

Let’s compromise
To keep things manageable, especially for handheld 
shooting, many photographers favour 70-200mm 
f/2.8 zoom lenses. They give good telephoto reach 
while still having a modest size and back-friendly 
weight of about 1.5kg. Better still, unlike budget 
telephoto zooms, the zoom mechanisms as well 
as focusing for all the zoom lenses in this group 
are fully internal, so the lenses remain fixed in 
length regardless of zoom and focus settings.

As an extra bonus for all of the 70-200mm 
f/2.8 lenses on test, the addition of a 2x extender 
(teleconverter) delivers a greater focal length of 
up to 400mm without much change to the overall 
length or weight. Meanwhile, the reduction of two 
f-stops to f/5.6 still enables autofocus on any 
Canon D-SLR. To find out how the Canon, Sigma 
and Tamron 70-200mm f/2.8 lenses performs with 
their relative 2x teleconverters, check out our 
super-telephoto Super Test from issue 94.

Gear Super Test

page://84
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Stabilisation and focus
Image stabilisation will typically give 
four stops of benefit in reducing 

camera-shake, ideal for handheld shots. 
The above EF 200mm f/2L IS lens has 
static and panning IS modes, selected via 
a switch, plus a more unusual preset focus 
option, complete with audible beep.

Focus modes and filters
Ring-type ultrasonic focus, as fitted 
to all lenses in this test, should be 

fast and whisper-quiet. Full-time manual 
focus override is available in One Shot AF 
mode. Lenses with a very large front 
element often feature a rear drop-in filter 
holder (as shown here, slightly raised).

Depth of field
A focus distance scale is usually 
positioned beneath a viewing 

window, often with markings to indicate 
the depth of field; this lens has markings 
for f/16 and f/32 apertures. As you can 
see, depth of field is quite shallow, even 
at these narrow apertures.

Make the most of fancy lens extras

Super Tip!
Given their 
typically large size 

and weight, most of the 
lenses on test come 
complete with a tripod 
mount ring, or collar. The 
exceptions are the Canon 
EF 70-200mm f/4 and 
the Canon EF 200 f/2.8. 
These lenses are rather 
lighter at 760g and 765g 
respectively, and 
therefore enable a 
comparatively good 
balance when the host 
camera body is attached 
to a tripod or monopod. 
Even so, an optional 
tripod ring is available, 
which not only improves 
balance, but also enables 
better setup for portrait 
orientation shooting. 
The genuine Canon Lens 
Tripod Mount Ring A II 
is suitable for both the 
above lenses in black or 
white, at around £125, 
but independently made 
copies are much 
cheaper to buy.

Take it slow, but keep up the quality
If you don’t need the fastest glass, consider these cost-saving options

A
long with their abilities to enable fast shutter 
speeds under gloomy lighting and to shrink the 
depth of field, fast lenses with wide apertures 

deliver a wonderfully bright viewfinder image. This 
makes it easy to track action and to focus manually, 
if and when desired. However, if you want telephoto 
or even super-telephoto zooms that deliver excellent 
image quality, but on a tighter budget, you can save 
money by sacrificing the wide, constant aperture.

One telephoto zoom that’s often overlooked is 
the Canon EF 70-300mm f/4-5.6L IS USM, at about 
£1,000. Sure, it’s no faster in terms of aperture than 
most budget lenses, but the optical quality and the 
performance of its autofocus and Image Stabilizer 
systems are superb. For even more telephoto reach, 
Canon’s relatively old EF 100-400mm f/4.5-5.6L IS 
USM lens has just been replaced by a brand new Mk II 
edition. This replaces the trombone-style push-pull 
zoom mechanism with a more popular rotating zoom 
ring, the optics are all redesigned and the Image 
Stabilizer is more effective. The price has jumped up 
from about £1,250 to £2,000, but this is likely to drop 
once the new lens has been on sale for a while.

Historically, many photographers have regarded 
300mm as a minimum useful focal length for wildlife 
photography. However, with the 1.6x crop factor of 
cameras like the 700D, 70D and 7D Mk II, a 200mm 
lens or zoom setting gives an ‘effective’ 320mm focal 
length. This enables smaller lenses to give greater 
telephoto reach in real terms. Naturally though, if you 
fit a 300mm or 400mm to a crop-sensor D-SLR, you 
get an even mightier effective reach of 480mm or 
640mm respectively.

Forego an f-stop or two and you can get  
great quality in a relatively compact package, 
and at a competitive price, as demonstrated by 
the excellent Canon EF 70-300mm f/4-5.6L IS USM

page://92
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Gear Super Test

Canon EF 70-200mm f/2.8L IS II USM

Canon EF 70-200mm f/4L IS USM

www.canon.co.uk

www.canon.co.uk

Excellent versatility and 
top-notch performance 95%
Rather pricer than competing 
70-200mm f/2.8 lenses

£960
Target Price

£1,670
Target Price

Compact, lightweight build, 
excellent image quality 90%
A full f-stop or more slower 
than other lenses on test

Favoured by professionals, the Mk 
II edition of this lens has earned an 
excellent reputation for its image 
quality, tough build and versatility. 
The design features top-grade 
fluorite glass and five UD (Ultra-low 
Dispersion elements), a virtually 
circular aperture based on eight 
diaphragm blades, and a dual-
mode Image Stabilizer, all wrapped 
up in a tough, weather-sealed 
magnesium alloy shell. 

At 1.49kg, this lens is marginally 
heavier than the other two Sigma 
and Tamron 70-200mm f/2.8 

lenses in the group but it feels more 
solidly put together, in keeping with 
its fully professional aspirations 
and higher asking price. Indeed, 
it’s about twice the price of the 
competing Sigma 70-200mm lens.

The ultrasonic ring-type 
autofocus system is super-fast, 
snapping into accurate focus even 
under dull lighting conditions. 
When the going gets really tough, 
speed can be improved by using the 
focus range limiter switch, which 
locks out the short end of the range 
between 1.2m and 2.5m. The 

late-generation Image 
Stabilizer gives a four-stop 
advantage, and all control  
rings and switches operate 
flawlessly. Image quality is 
razor-sharp throughout the 
zoom range, even at f/2.8, 
while distortions, vignetting 
(darkened image corners)  
and colour fringing are all 
particularly well controlled.

Shaving about half the weight and 
a third of the price off Canon’s 
70-200mm f/2.8 lens that’s also 
on test, this one is an f-stop slower 
at f/4. That makes it the slowest 
lens in the whole group, but upsides 
include a remarkably compact 
build, with a relatively small filter 
thread of 67mm. Weighing in at 
760g, the lens is also lightweight 
enough for even prolonged 
stretches of handheld shooting.

The layout of control switches is 
practically identical  to that of 
Canon’s 70-200mm f/2.8 lens, with 

a focus range limiter (this time 
locking out the 1.2-3m range), AF/
MF focus modes, stabiliser on/off 
and stabiliser static/panning 
modes. The zoom and focus rings 
have the same orientation in both 
lenses but, while the focus rings are 
in approximately the same position, 
the rubber grip on the f/4 lens ring 
is rather narrower.

Quality glass includes a single 
fluorite element and two UD 
elements, and the diaphragm is 
based on eight blades to give a 
rounded aperture. Autofocus is 

very quick and highly accurate. 
Image quality is almost as good 
as from the more upmarket 
Canon 70-200mm f/2.8 lens, 
in terms of sharpness and 
contrast, fringing, vignetting 
and distortions. It’s a great 
lightweight option but, if you 
want to add a 2x extender, 
you’ll have to focus manually 
on most Canon D-SLRs.
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Canon EF 200mm f/2L IS USM

Canon EF 200mm f/2.8L II USM

www.canon.co.uk

www.canon.co.uk

£4,450
Target Price

£570
Target Price

Superb build quality and image 
quality; 5-stop Image Stabilizer 95%
Heavy for handheld shooting; 
extremely expensive to buy

Compact; lightweight; delivers 
very good image quality 82%
No image stabilisation, nor 
the versatility of zoom

Manual mode explained See page 72

Canon’s latest line of ultimate-
quality, high-tech telephoto primes 
include 300mm and 400mm f/2.8 
lenses at around £4,900 and 
£7,800 respectively, but this one’s 
the fastest at f/2. It’s certainly no 
lightweight in terms of build or 
price, tipping the scales at 2.52kg 
and costing £4,450. However, the 
fully professional build is rock-solid 
and there’s the usual up-market 
mix of fluorite and UD elements.

The extra-wide front element 
precludes the fitment of an 
attachment thread, but drop-in 

filters can be placed at the rear of 
the lens. This is where most of the 
controls are located, including the 
usual AF/MF, focus range limiter, 
stabiliser on/off and stabiliser 
mode switches. On top of that,  
you get a focus preset switch with 
audible beep option. Further 
forwards are four autofocus stop 
buttons for freezing the action of 
autofocus, plus a ‘playback’ ring, 
which is used to launch the 
super-fast autofocus system to a 
previously stored focus distance.

The f/2 widest aperture enables 
a noticeably tighter depth of 
field than various 200mm 
f/2.8 lenses on test. What’s 
more remarkable is that 
sharpness and contrast are 
incredible, even at f/2. It’s a 
fabulous lens, but the huge 
asking price puts it beyond the 
reach of most of us and the 
versatility of a zoom lens can 
often be more desirable.

What a difference an f-stop makes. 
Whereas Canon’s 200mm f/2 
prime lens is one of the heaviest 
lenses in the group, this lens 
matches it for focal length but, with 
its narrower maximum aperture of 
f/2.8, it’s much smaller and lighter 
in weight. Whereas the physical 
diameter of the f/2 lens is too large 
for a filter attachment thread, this 
lens takes regular, modestly sized 
72mm filters and weighs in at just 
765g instead of 2.52kg.

Most L-series telephoto lenses 
are painted off-white, to minimise 

heat build up when shooting under 
hot sunshine. It’s not such an issue 
with smaller lenses, so this one is 
finished in black and looks rather 
more inconspicuous. Worse news 
is that, unlike most L-series lenses, 
there are no weather-seals. 
Autofocus is fast and accurate, 
however, and there’s a focus range 
limiter to omit close-focusing in the 
1.5-3.5m range.

While the lightweight build 
makes for comfortable handheld 
photography, use of the lens in dull 
lighting conditions suffers from the 

lack of an image stabiliser. 
Indeed, it’s one of only two non-
stabilised lenses in the entire 
test group. Dangers of 
camera-shake aside, image 
quality is very good, with 
impressive sharpness and 
contrast that are almost as 
good as in the more recently 
designed Canon 70-200mm 
zoom lenses on test.
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Gear Super Test

Sigma APO 70-200mm f/2.8 EX DG OS HSM

Sigma 120-300mm f/2.8 DG OS HSM S

www.sigma-imaging-uk.com

www.sigma-imaging-uk.com

Good image quality; effective 
stabilisation; bargain price 86%
No weather seals, nor a 
focus range limiter switch

£750
Target Price

Looking every inch a bargain, 
this Sigma lens goes into direct 
competition with Canon’s 70-
200mm f/2.8 image-stabilised 
lens, but at a shade under half the 
price. Highlights include quality 
glass, with two FLD (F Low 
Dispersion) elements, which are 
claimed to rival top-class fluorite 
glass, a further three SLD (Special 
Low Dispersion) elements, and 
Sigma’s Super Multi-Layer Coating 
to reduce ghosting and flare. The 
ring-type HSM ultrasonic autofocus 
system is very fast and super-

smooth in operation and the 
dual-mode static/panning image 
stabiliser is rated at four stops.

Look a little closer, however, and 
there are some minus points in the 
lens’s construction. As you might 
expect at the lower price, it lacks 
the Canon lens’s magnesium alloy 
barrel sections, instead relying on 
high-quality plastics, and the Sigma 
also lacks weather seals or even a 
focus range limiter switch. 

Even so, image quality is very 
good indeed. It’s not quite as 
razor-sharp as the Canon lens, 

especially at the short end of 
the zoom range when using the 
widest f/2.8 aperture, but it’s 
not that far behind. The Sigma 
is also a little more prone to 
ghosting and flare when 
shooting into the light but, 
overall, it’s an excellent 
budget buy for this class of 
lens, offering unbeatable 
value for money.

This enormous lens dwarfs most 
others in the test group. It 
measures a whopping 121x291mm 
and weighs a massive 3.39kg,  
so handheld photography isn’t 
something to be taken lightly.  
Even so, the lens features Sigma’s 
dual-mode image stabiliser for 
static and panning shooting, which 
is well worth engaging even if you’re 
using a monopod.

The lens is unique in offering  
a zoom range that stretches to 
300mm, while also having a fast 
f/2.8 constant aperture. Two FLD 

elements and an SLD element are 
used in the construction which, 
unusually for a Sigma lens, also 
boasts weather seals. As one of 
Sigma’s S (Sport) lenses, it’s 
compatible with the company’s 
optional USB dock. This enables 
customisation of focus range 
limiting, autofocus speed and 
stabilisation attributes, which can 
then be accessed via the Custom 
switch on the lens barrel.

Sharpness and contrast are very 
good throughout the entire zoom 
range, even at f/2.8, although 

they’re not quite a match for 
the mighty Canon 200mm f/2 
prime lens. Impressively for a 
zoom lens, distortions are 
absolutely minimal. There’s 
also very little colour fringing. 
Overall image quality is very 
pleasing, the long zoom range 
is a real bonus and the lens is 
a joy to use, despite being 
such a heavyweight.

£2,800
Target Price

Long zoom range; constant 
f/2.8 aperture; weather seals 88%
Very big and heavy for 
prolonged handheld shooting
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Sigma APO 300mm f/2.8 EX DG HSM

Tamron SP 70-200mm f/2.8 Di VC USD

www.sigma-imaging-uk.com

www.tamron.eu/uk

Compared with the Canon 200mm 
f/2 lens that’s on test, this Sigma is 
a stop slower but has a longer 
telephoto reach with its 300mm 
focal length. It’s also only about 
half the price, but looks rather 
low-tech. Whereas the Canon is 
positively bristling with fancy 
features and controls, the Sigma 
lacks an image stabiliser, doesn’t 
have a focus range limiter, and 
there are no weather seals or trick 
focusing preset facilities. Despite 
all this, this Sigma lens feels very 
solidly built and is of a very similar 

size and weight to the Canon 
200mm lens.

Unlike the other two Sigma 
lenses on test, there are no ‘fluorite’ 
quality glass elements, but the two 
largest elements at the front of the 
optic have an ELD (Extraordinary 
Low Dispersion) classification. In 
fact, the front element is so large 
that, like the Canon 200mm lens, 
there’s no filter attachment thread, 
the Sigma instead offering a 
drop-in placement for 46mm filters 
towards the rear.

Image quality is very good in all 
respects, although the Sigma 
isn’t quite as sharp or rich in 
contrast as the Canon 200mm 
prime lens. In fact, image 
attributes are almost identical 
to those of the Sigma 120-
300mm. Ultimately what you 
lose in zoom versatility and 
stabilisation, you make up for 
in the smaller, more 
lightweight build.

Tamron’s 70-200mm lens goes 
toe-to-toe with the equivalent 
Sigma. Similarities include fast and 
efficient ring-type ultrasonic 
autofocus, image stabilisation and 
high-quality glass, in this case 
employing XLD (Extra Low 
Dispersion) and LD (Low 
Dispersion) elements to maximise 
sharpness and contrast, while also 
aiming to minimise colour fringing. 
Both lenses also omit a focus range 
limiter switch.

A notable difference between 
the Tamron and Sigma 70-200mm 

lenses is that the Tamron adds 
weather seals. Naturally, this is a 
bonus if you’re shooting outdoors 
in inclement conditions. However, 
a drawback of the Tamron is that 
its VC (Vibration Compensation) 
system lacks a panning mode like 
other lenses tested in this group. 
Tamron claims that its proprietary 
system should work well for 
panning but, in our tests, the Canon 
and Sigma stabilisation systems 
were more effective. That said,  
VC works well for static shots, 
giving a four-stop benefit.

There’s very little to choose 
between the Tamron and 
Sigma 70-200mm lenses for 
image quality, the only real 
difference being that the 
Tamron is a little sharper when 
combining its shortest focal 
length with its widest aperture 
of f/2.8. The Tamron is more 
expensive but is better suited 
to wet-weather shooting.

£2,280
Target Price

£1,000
Target Price

Long telephoto reach; fast 
f/2.8 aperture; sensible price 85%
Lacks image stabilisation or a 
focus range limiter switch

Good build quality; weather 
seals; good sharpness 85%
Stabilisation system lacks 
effectiveness for panning

Next issue Home studio lighting kits
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1  Apertures of f/2 or f/2.8 are great for blurring 
backgrounds, but could be too wide on sunny 

days, so you may need to use a neutral density filter 
when you want the shallowest depth of field.

 Five things we 
learned in this test

2  The size and weight of the lenses on test vary 
enormously, so it’s worth checking the 

figures if you’re into handheld photography.

3  Image stabilisation is a real bonus for 
telephoto shooting, not only for handheld 

shots but also when using a monopod.

4  Weather seals are useful, especially for 
sports, wildlife and other forms of outdoor 

photography where you may need to shoot in the 
rain or in dusty environments.

5  Focus range limiters can speed up autofocus 
performance in very poor light or for tricky 

subjects, limiting the amount of autofocus 
hunting that may occur.

The two standout lenses in this group are the Canon EF 
70-200mm f/2.8L IS II USM and the Canon EF 200mm f/2L IS 
USM. The latter delivers the most spectacular image quality 
but the smaller size, lighter weight and zooming versatility of 
the 70-200mm makes it the best buy, especially considering it 
costs about a third of the price. If £1,670 is still too much to 
pay, the Sigma APO 70-200mm f/2.8 EX DG OS HSM is 
unbeatable value at £750. There’s little to choose between this 
lens and the equivalent Tamron for image quality but, while the 
Tamron adds weather seals, it lacks a panning mode for its 
stabiliser. We also love the relatively lightweight Canon EF 
70-200mm f/4L IS USM, despite it being a stop slower than 
the f/2.8 lenses.

For stretching beyond the 200mm focal length boundary, 
while still enjoying a fast f/2.8 aperture, the Sigma 120-
300mm f/2.8 DG OS HSM S and Sigma APO 300mm f/2.8 
EX DG HSM rule the roost. Of these two, we prefer the 
120-300mm lens, for the flexibility of its zoom without any 
drop in image quality and the addition of image stabilisation.  

Name Canon EF 
70-200mm 
f/2.8L IS II USM

Canon EF 
70-200mm 
f/4L IS USM

Canon EF 
200mm f/2L 
IS USM

Canon EF 
200mm f/2.8L 
II USM

Sigma APO 70-
200mm f/2.8 
EX DG OS HSM

Sigma 120-
300mm f/2.8 
DG OS HSM S

Sigma APO 
300mm f/2.8 
EX DG HSM

Tamron SP 70-
200mm f/2.8 Di 
VC USD

Full-frame compatible Yes Yes Yes Yes Yes Yes Yes Yes

Effective focal length 
(APS-C)

112-320mm 112-320mm 320mm 320mm 112-320mm 192-480mm 480mm 112-320mm

Image stabiliser 4 stops 4 stops 5 stops None 4 stops 4 stops None 4 stops

Minimum focus distance 1.2m 1.2m 1.9m 1.5m 1.4m 1.5m to 2.5m 2.5m 1.3m

Max magnification factor 0.21x 0.21x 0.12x 0.16x 0.13x 0.12x 0.13x 0.13x

Autofocus actuator Ultrasonic 
(ring-type)

Ultrasonic 
(ring-type)

Ultrasonic 
(ring-type)

Ultrasonic 
(ring-type)

Ultrasonic 
(ring-type)

Ultrasonic 
(ring-type)

Ultrasonic 
(ring-type)

Ultrasonic 
(ring-type)

Full-time manual focus 
override

Yes Yes Yes Yes Yes Yes Yes Yes

Focus range limiter Yes Yes Yes Yes No Yes No No

Internal zoom Yes Yes N/A N/A Yes Yes N/A Yes

Internal focus Yes Yes Yes Yes Yes Yes Yes Yes

Filter size 77mm 67mm 52mm (drop-in) 72mm 77mm 105mm 46mm (drop-in) 77mm

Weather-seals Yes Yes Yes No No Yes No Yes

Supplied accessories Pouch, hood, 
tripod collar Pouch, hood Case, hood, tripod 

collar Pouch, hood Pouch, hood, 
tripod collar

Pouch, hood, 
tripod collar

Pouch, hood, 
tripod collar Hood, tripod collar

Dimensions (Dia x Length) 89x199mm 76x172mm 128x208mm 83x136mm 86x198mm 121x291mm 119x215mm 86x197mm

Weight 1.49kg 760g 2.52kg 765g 1.43kg 3.39kg 2.4kg 1.47kg

Weight £1,670, $2,200 £960, $1,300 £4,450, $6,000 £570, $775 £750, $1,200 £2,800, $3,600 £2,280, $3,400 £1,000, $1,500

Verdict 95% 90% 95% 82% 86% 88% 85% 85%

Fast Telephoto Lenses at a glance





Advertisement promotion

EssEntial WildlifE 
photo kit Capture stunning shots of nature 

with this superb selection of 
wildlife photography equipment
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Bushnell Excursion HD Binoculars
Price: £279.95

Bushnell Excursion HD 8 x 42mm binoculars are perfect for spotting wildlife. With 
a wide field of view, the housing is nitrogen filled and sealed for 100% water and 
fogproof performance in all weather conditions, ensuring you don’t miss a thing. 
The textured rubber armour provides a non-slip grip, whilst the large and lockable 
centre focus wheel is easy to use when it’s cold, wet or you are wearing gloves. 

Realtree Xtra camera  
and lens cover
Web: www.wildlifewatchingsupplies.com Price: From £36.78

Sometimes the most striking of pictures are taken in the harshest 
of conditions. Wildlife Watching Supplies’ camera and lens covers 
are available in a wide range of sizes and patterns, and offer perfect 
weather, dust and dirt protection for your kit, as well as excellent 
camouflage for wildlife photography, and keeps you going when 
other photographers have packed their kit away.

Sigma 150-600mm 
f/5-6.3 DG OS HSM S
Web: www.sigma-imaging-uk.com  Price: £1599.99

The new benchmark in telephoto zoom lens 
technology, Sigma’s 150-600mm f/5-6.3 DG 
OS HSM S lens features dust and splash-proof 
construction, twist and push/pull zoom action 
with zoom locking at every focal distance, water 
repellent coating, a new MO mode switch and new 
(optional) teleconverters enabling AF at f/8.
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Manfrotto 
BeFree tripod
Web: www.manfrotto.co.uk   
Price: £279.95

The perfect companion when 
photographing wildlife, the BeFree 
Carbon is extremely stable and weighs 
just 1.1kg. The 100% carbon fibre legs 
ensure rigidity and transportability – and 
thanks to the unique mechanism, the legs 
fold tightly around the head and quick-
release plate attachment, down to a length 
of just 40cm. Fast to set up and intuitive to 
use, the BeFree Carbon helps you capture 
stunningly precise and sharp images.

Manfrotto Advanced Travel Backpack
Web: www.manfrotto.co.uk  Price: £109.95

The Advanced Travel Backpack is the perfect solution for the wildlife 
photographer who wants to carry everything with them. Photographic gear, 
tripods and personal belongings can perfectly fit in one single compact 
volume, with the interchangeable dividers allowing you to custom fit the inside 
of your bag around your gear.  If needed, the extendable padded pocket on the 
side provides additional room for a travel-size tripod, such as the BeFree.

Bushnell 
NatureView 
Cam HD
Price: £309.95

Capture nature at its finest in 
stunning HD with the Bushnell Nature 
View Cam. This durable, reliable camera 
records video and images you may never 
get the chance to capture in person. The 
Nature View Cam can run for up to one year 
on one set of batteries and features an 

8Mp CMOS sensor, auto passive infrared 
motion sensor and Hyper NightVision 

technology, with a 32-LED flash, 
which has a 60ft range.
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On sale Tuesday 31 March 2015
All content subject to change! 
*Our Master Macro pullout has moved to next issue – we had to make room 
this issue for the exciting new 50-megapixel Canon EOS 5DS (see page 55). 

Plus…

+ Free 
videos!

Master your eos d-sLr 
and PhotoshoP with 

our great video guides

Sssshhhh… learn clever D-SLR setup tips  
that Canon would rather you didn’t know

Canon 
SeCretS!

Don’t miss our Spring issue! 

Antony Edmonds

Professional

enthusiast

entry-level

  White-water action! The Official GB canoeing team photographer 
teaches our Apprentice how to take fast-paced slalom paddling shots

  Free Master Macro pullout guide* Follow our new step-by-step 
projects and discover how to take great macro shots in your home

  PhotoPlus Workshop Metering modes under the microscope

  Super Test! Budget studio lighting kits – prices starting at £170

  Great new projects to try How to great creative with 
portraits and mirrors, tilt-shift lens ‘model village’ 
photos, and segmented scenic shots! Plus new 
Photoshop Elements tutorials and videos

suPer shortcuts!

page://55


Shot in the Back
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I’m an ocean lifeguard who works 
the summers in Australia and 
photographs the world during the 
winter months. During my travels 

I have developed a special friendship with the Himba 
people of Epupa, Namibia. This relationship sees me 
travel to the country each and every year – I have 
been doing so for the past decade now – and I run 
regular photographic tours during which I am able to 
share my contacts and knowledge with other 
like-minded photographers.

This shot was actually set up as a demonstration 
while on my Namibian Photographic Experience tour 
in 2014. I don’t usually lean towards posed images 
but I wanted to demonstrate how effective a single 
Canon 580EX II Speedlite can be to light up a group 
evenly. I had one of the photographers 
accompanying me on the trip, Stef De Klerk, fire 
the shutter in my direction while I moved around 
positioning the off-camera flash.

Once the tribesmen were in place, I positioned my 
Canon EOS-1D Mk IV on a tripod, so the camera 

could not move, and I dialled in manual settings of 
1/10 sec at f/6.3; ISO400. I wanted to add a little 
light to the scene as this image was shot after the 
sun had set. The Canon EF 24-70mm f/2.8L II USM 
lens was working well with these settings, and so it 
was a matter of me running around very quickly with 
the Speedlite to light up various areas of the scene.

After taking 25 shots or so, I knew I had lit the 
area and the men more than sufficiently; in the end 
it only required six shots to be composited together 
in Photoshop to give me the result I was after. It was 
a great demonstration of what can achieved if you 
think a process through.

Once we were back in camp I began to put all  
of the pieces together. I selected six images that  
had given me the best light on the men and their 
surroundings and merged these parts of the images 
together using layer masks to give me the complete 
scene that I had in my head. All that 
was left to do then was to dodge  
and burn the areas that I felt needed  
a little bit of pop or contrast. 

My favourite shot
Ben McRae tells us how he used a single flashgun – and a lot of 
legwork – to create his evocative shot of the Himba tribesmen

Ben McRae 
www.benmcrae 
photography.com
Age: 34 
Location: Wollongong, 
Australia
Semi-pro for: 10 years

http://www.benmcraephotography.com
http://www.benmcraephotography.com
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